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Chapter 1 – Overview 

Welcome 
Welcome to Archive Manager, the leading-edge commercial record management system for record 
centers of all sizes.  

Based decades of record management experience, and featuring leading-edge Microsoft .NET and 
Microsoft SQL technologies, Archive Manager provides record centers with the powerful and flexible 
tools they need to manage and grow their business.  

Archive Manager is a functionally complete software package as delivered. Record Management 
Software, Inc. does not levy a “per-transaction tariff” to Archive Manager users.  

For complete pricing details, see http://recordmanagementsoftware.com/wp/archive-manager  

Optional components include:  

 Voice prompted bar code scanner  
 Web Access Module 
 Web based Client Data Entry software 
 Multiple-user versions 
 Bridge software to accounting systems other than QuickBooks 

ARCHIVE MANAGER FEATURES 

 A full-featured security module protects and controls access to the system. 
 Concurrent multiple open windows for easy switching between tasks. 
 User groups allow assignment of personalized access rights to any screen.  
 Quick access to box-size, media, location and billing management speeds information entry and 

retrieval.  
 Customer data entry at a single screen is simple and quick. Clients can be associated with any 

number of contacts and departments. 
 Billing can be entered either manually or automatically per action. 
 The optional Web Access Module allows clients to access their accounts via the Internet 24 x 7, to 

lookup and checkout from their holdings, print reports, and order supplies. Users may be limited to 
one department or may view all items. 

 An optional Web-based Data Entry Module allows clients to enter new boxes and folders into the 
Archive Manager system over the Internet. Boxes and folders arrive at the warehouse with data 
already recorded in the system.  

 Customer and billing information can be exported to QuickBooks (or by special order, to most 
other accounting systems). All charges including the monthly storage charges are computed 
monthly or daily to invoices that can be exported. 

 Contract information is retrieved at the click of a button. 
 A Quick Lookup facility puts important, often used information at your fingertips. 
 A comprehensive audit trail keeps a complete history of each box and folder.  
 A convenient report generator provides hundreds of useful reports with a built in PDF generator. 
 Save-and-reuse action lists save time and effort. 
 The optional portable bar code reader is voice-prompted to simplify use. It speeds box, folder and 

shelf handling, enhances data accuracy, and permits flexible editing of data prior to updating the 
database. 

http://recordmanagementsoftware.com/wp/archive-manager
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Navigating in Archive Manager  

THE MENU BAR 

 
 Fig. 1 

 
Navigation in Archive Manager will be intuitive for anyone accustomed to standard Windows software. 
When the application is initialized, the default screen appears. There is a Menu Bar situated at the top, 
as usual, where menu items are selected with a left-mouse click. Most of Archive Manager’s features 
can be accessed from the Menu Bar, but you will find that there are usually quicker ways of accessing 
the more often-used ones. 

THE ACTIVITY PANE 

Icons in the Activity Pane to the left of, the Archive Manager screen, provide quick access to often 
used features and activities, including menu choices, quick searching, and the currently-open window. 
Any item may be accessed with a single mouse-click. 

THE SHORTCUTS PANEL 

The Shortcuts Panel (Fig. 2) appears by default when Archive Manager is 
initialized. Click any icon to jump to its associated activity.  

 Audit Trail – The Audit Trail feature tracks activity history for boxes 
and folders – discussed in Chapter 10. 

 Quick Search – Find is a search utility for quick retrieval of box, folder, 
location, and customer information – discussed in Chapter 9. 

 Billing – The Billing Screen is used for entry and display of customer 
charges – discussed in Chapter 11. 

 Reports – The Reports Module is used for selection and 
customization of reports – discussed in Chapter 14. 

 Import – The Import Screen contains all functions for importing and 
exporting client data – discussed in Chapter 17. 

 Business Status – The Business Status Applet displays the current 
number of boxes, folders, clients, and permanent (box) labels, and 
displays the Next box # (Fig. 3). 

Fig. 2 

 
   
  

     

 

 Fig. 3 
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THE MAINTAIN PANEL  

Clicking the Maintain Tab in the Activity Pane causes the Maintain Panel to appear (right), with the 
following icons: 
 
 Boxes – Screen for management and display of box information. Discussed in 

Chapter 5. 
 Folders – Screen for management and display of folder information. Discussed 

in Chapter 6. 
 Tapes - Screen for management and display of box information. Discussed in 

Chapter 7. 
 Clients – Screen for management and display of customer information. 

Discussed in Chapter 3. 
 Record Titles – discussed in Chapter 4.  
 Lists – discussed in Chapter 7.    
 Orders - discussed in Chapter 8. 
 Locations - discussed in Chapter 2 Getting Started.           

     
 
 Fig. 4 

 

 
THE QUICK SEARCH PANEL 

Clicking the Quick 
Search Tab in the 
Activity Pane brings  
up the Quick Search 
Panel, which allows 
quick retrieval of 
information about 
boxes, folders, 
locations, and 
customers. It is 
discussed in  
Chapter 8. 
 
 
 
 
 
 
 
 
 
 
 Fig. 5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

THE ACTION LIST PANEL 

Clicking The Action 
List Tab puts the all 
the Menu Bar 
functions into the 
Activity Pane. Double 
clicking an item here 
is the same as 
selecting it from the 
Menu Bar. 

 

 

 

 

 Fig. 6 
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THE OPEN WINDOWS PANEL 

The last item in the Activity Pane is the Open Windows Panel. This area lists the names of each 
currently open window. In Fig. 7, below, the Charges, Maintain Clients and Maintain Boxes Screens 
are open. A single click on any name will activate the corresponding window. If you are entering 
charges, for example, and need to look up a box number, you can just toggle windows and never lose 
your place. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Fig. 7 

FILTERING 

Situated at the top of most Archive Manager screens are multiple filters, which you can use to limit the 
data displayed on the screen to the information you want for each field. These filters can be used 
singly or in conjunction to perform a search.  

In the Sample database’s Box Screen, for example, if you enter ROYAL in the Client field, only boxes 
belonging to ROYAL are displayed. If 5-O-018 is then entered in the Location field, ROYAL’s Box # 
763830 is displayed. Any additional ROYAL boxes that are placed in this Location would also be 
displayed. 

The wildcard character is %, meaning “accept any value”. It may be used in any part of a query. 

SORTING 

Click the bar at the top of a column of data (in any screen) to sort the display in ascending order. Click 
again to reverse the order. 
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WINDOWS CONVENTIONS 

Archive Manager uses standard Windows conventions regarding the mouse and keyboard shortcuts: 
right-clicking on most items brings up an action menu.  

At the upper left of any screen containing a list, under the title bar, you will find a chevron symbol. 
Clicking the chevron expands the list view so that it fills the window. 

A button panel is located at the bottom of each screen. The buttons function as follows: 

 Print – Click the button to print the data in the active screen in the order 
displayed.  

 Edit – Click any row in the active screen to select it, then click Edit to edit it. Or, 
you can just double click an item in the form. 

 Add – Click the button to add a new record to the form or table. 

 Save & Add – Click the button to continue adding new records to a form. 

 Delete – Click any row in the active screen to select it, then click Delete to remove 
it. A warning pops up and asks if you are sure. 

 Close – Click the button to close the current screen. Or, you may hit the X in the 
upper right or double click the upper left corner of the screen. 
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Chapter 2 – Getting Started 
Getting Started in Archive Manager is primarily about getting organized. A successful implementation 
depends more on the organization and quality of your existing data than on how it will be handled by 
Archive Manager.  

Whether you are just getting started in a new business, or converting information for records that have 
been in use for many years, it is critically important to carefully consider all the types of information 
you will require – date received, storage location codes, box size codes and descriptions, destroy 
dates, folder parameters, billing codes, etc. – before you begin entering data. These items must be 
defined to the Archive Manager software before deployment, and some of them are difficult or 
impossible to change after you are under way. 

Company Setup 
The Company Setup 
screen (right) is where you 
will enter information about 
your own company. To 
open the screen, click 
Security > Setup on the 
Menu Bar. 
 
 Fig. 8 
 

 

Please note that your company’s name, address, and phone number will appear on the bottom of all 
the reports to your clients exactly as it is entered here. Some of these fields are straight forward, but 
others require some explanation. 

LOGO 

Archive Manager can use your company logo as a background on many of its screens. Enter the logo 
file’s path name in the Logo Field to identify it to Archive Manager (not yet implemented as of this 
writing). 

ACCOUNT 

 This is the name of the income account in QuickBooks (or other accounting software) to which 
customer charges are exported. This is explained in Chapter 11 – Billing. Account 

Tax Agency 

The Tax Agency is the taxing authority, as specified in your accounting software, to whom sales tax is 
reported. This is likewise explained in Chapter 13 – Using Archive Manager with QuickBooks. 

LAST BOX # 

The Last Box # field is the “counter” for your bar coded box labels. When bar coding is in use, a 
unique Box Number is assigned to each arriving box. Archive Manager stores the last assigned 
number in this field, and adds 1 to determine the next number to assign. 
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When you begin using Archive Manager, you must specify the beginning number that the computer 
will use. If you already have 100,000 Boxes in storage, you might want to set this number to 101,000 
to give yourself a small buffer. Remember that Box Number is a 9-digit field, so you can have almost a 
billion box numbers. 

 IMPORTANT: You should never set this number lower than the number of boxes already in 
storage because, if you have given any of your clients preprinted client Box Labels, numbers 
might be duplicated. 

QUICKBOOKS FILE  

A QuickBooks File is used only if you will be linking Archive Manager to QuickBooks. In that case, 
Archive Manager needs to know where to find the data file in which QuickBooks stores your 
accounting information. You can click the ellipse to the right of the field to navigate to file’s location. Its 
extension is *.QBW, and it is usually found in: 

 
    C:\ProgramFiles\Intuit\QuickBooks\[QuickBooks account name].QBW.  

Be certain that the file’s full (absolute) pathname is entered. 

If you are NOT linking Archive Manager to QuickBooks, leave the field blank. 

SAVE LOCATION 

The Save Location feature is used if your record center reserves a storage space after a box is 
checked out so that another one cannot be stored in its place. If it does not use this system, the item 
should be left unchecked. 

 IMPORTANT: This parameter cannot be easily changed once you begin to use the software. 

TAX ON STORAGE 

Although uncommon, some states require that you collect sales tax on storage fees. When this item is 
checked, Archive Manager calculates sales tax and adds it to the billing. Default configuration is 
unchecked. Tax on Storage 

SHOW BOXES NUMBER FOR MINIMUM STORAGE FEE 

For clients that receive a minimum storage fee, you have a choice to list the number of boxes by box 
size on the monthly invoice. Default configuration is unchecked  

ALLOW DUPLICATE BOX # 

As delivered, Archive Manager is configured with Allow Duplicate Box item unchecked by default, so 
that no two boxes can be assigned the same Box Number. It is strongly recommended that duplicate 
box numbers not be permitted.  

 IMPORTANT: This parameter cannot be easily changed once you begin to use the software. 

ONE INVOICE/MONTH 

When One Invoice/Month is checked, Archive Manager issues a single monthly invoice for each client 
that combines monthly storage and service charges. If left unchecked, two invoices will be generated 
for each client, one for storage and another for services. This is easily changed from month to month. 
Default configuration is unchecked.  
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User Groups 
When you log into Archive Manager 
for the first time using the superuser 
password you received (right), you 
will be able to create both user 
groups with common rights and 
permissions, as well as individual 
users. A password must be provided 
after each user is created.  

 

 

 

 

 Fig. 9 

 

 

 

 

 

 

 

On the Menu Bar, click Security > 
User Groups to enter the User 
Groups Screen, and click the Add 
button to add a new user group. Enter 
a name for the group, such as 
Lookup or Power Users.  

 
 

 

 

 

  
 Fig. 10 
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Then click Edit Modules to assign rights to the group you added. Select the item to assign in the 
upper scroll box (below), and then select the level of access in the lower scroll box (not visible in 
illustration). 

The level choices are: 

 Full access 
 No Access 
 Read Only 
 Browse Only 
 

 

 

 

 Fig. 11
  

 

 

 

 

Click Continue; the Setup User 
Groups Screen appears (right), 
populated with the added groups. 

To edit existing user Groups, 
simply double-click the desired 
group. 

 

 

 

 
 
 

 Fig. 12 
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Folder Field Labels 
From the main top menu click Setup and pull down to Field Labels.  
 

This feature allows you to 
change the names of certain 
fields related to folder 
information throughout the 
system. The text in the boxes 
represents the individual field 
names that appear on the 
Folder Information Screen.  

You can change the following 
fields 

 Major Description 

 Minor Description 

 Matter No.        Fig. 13 

 Client 

Type over the field names to 
change to whatever makes 
sense to you. 

When you are finished making changes, click Save 
These field names will appear on the folder edit screens and folder reports throughout Archive 
Manager. 
 
Note - if at any time you want to return to default field labels, just click Return to Original Value. 

Box Size Code 
To enter the Box Size Screen, click Setup > Maintain Box Sizes on the Menu Bar. 

Archive Manager allows you to 
define, and update as needed, all 
of the different box sizes you will 
be storing. Each different box size 
is represented by a 10 position 
alphanumeric code which is 
entered into the Master Box Size 
Code file. Archive Manager uses 
this file to verify box information 
as it is entered, and to calculate 
storage fees. 

 

 

 Fig. 14
  

 

Data for each Master Box Size 
consists of: 

 Code – 10 positions alpha/numeric (Code field) 
 Name – 30 positions alpha/numeric 
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clients Billing Code file for each 
new client entered in the system. 
This way, if your company has 50 
or more services, you only need to  

 
 

 Cubic Feet – 9 positions numeric with 4 decimal positions 
When a client is to be billed per cubic foot, Archive Manager uses the information in the Client 
Box Size Code file and the Billing Rate in the Client Master to calculate their storage fee. 

 Cost Per Box – 10 positions numeric with 4 decimal positions 
Cost per Box: When a client is to be billed ‘per box’ the computer will use the cost field as the rate 
they are to be billed for the total number of that size box. 

 IMPORTANT! Master Box Size Codes must be entered into Archive Manager before you begin 
entering any client data, and before any locations can be set up. 

It is useful to think of the Master Box Size Code as a template that is used each time you set up a new 
client. 

As new clients are entered in Archive Manager, the Master Box Size and Billing Codes are copied into 
the client’s files. If the Master Box Size Codes are omitted at this stage, neither box sizes nor billing 
codes will be established for those clients. It would then be necessary to enter the Box Sizes and 
Billing Codes one-by-one for each added client - an onerous task. 

Filter – You may put any code or name into the filter boxes and click the Filter button to search for a 
box size code. Remember that you can sort on the form by clicking the column heading. 

Billing Codes 

THE MAINTAIN BILLING CODES SCREEN 

Billing Codes are used to 
describe the various services for 
which your company charges 
fees; i.e., pick up, delivery, 
retrieval, indexing new boxes, etc.  

To access the Maintain Billing 
Codes Screen, click Setup > 
Billing Codes on the Menu Bar. 

Although Archive Manager 
permits you to set up individual 
rates for every service for each 
client, a majority of clients will pay 
a default fee for most  
services. The master set of Billing 
Codes is simply a default set of 
values that Archive Manager 
automatically copies into the  
 

 Fig. 15 

specify any exceptions to the default values as you set up each new client. 

When a flag notifies Archive Manager that a fee should be prorated, the billed amount will be 
calculated based upon the date a box or folder was received and the number of days in that month. 
Prorating is used when new boxes are received during the monthly billing cycle, so that storage can be 
charged for each day remaining in the cycle. 

Filtering – You may put any code and/or description into the filter boxes and click  
the Filter button to search for a billing code. Remember that the wildcard character is %. 
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 NOTE: The Master Billing Codes must be entered in Archive Manager before you begin entering 
clients. 

THE CURRENT BILLING CODE SCREEN 

Billing Codes are edited on the Current Billing Code Screen. To enter this screen from the Maintain 
Billing Codes Screen, either highlight the desired code and click Edit, or simply double-click the code 
you wish to edit.  

The fields are as follows: 

 Taxable – check this box if this item is 
subject to sales tax. 

 ProRate – check this box if this item is 
going to be prorated for days in a 
month. 

 Autobill – check this box if fixed 
charges are to be billed automatically. 

 Code – this is a 10 position 
alphanumeric field 

 Description – the description of the 
billing item. 

 Unit of Measure – each, boxes, hours, etc.                              Fig. 15 
 Billing Rate – the rate in   

dollars to 4 decimal places 
 Tax Rate – the tax rate in decimals. 
 Change Client’s Billing Rate – check this box to change all clients’ rates that match the master 

rate. Clients with a special or different billing rate will not change. 
  
 

Media Codes 

THE MEDIA LIST SCREEN 

Media Codes can be used to 
describe any box or file features on 
which you may wish to perform a 
search.  

To access the Media List Screen 
(right), click Setup > Media Codes 
on the Menu Bar. 

Filter – You can filter on any Media 
Code or Name as described above. 

 

      Fig. 17 
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THE CURRENT MEDIA SCREEN 

Media Codes are edited at the 
Current Media Screen. To enter this 
screen from the Media Codes 
Screen, either highlight the desired 
code and click Edit, or simply double-
click the code you wish to edit.  

 

 

 

 

  Fig. 18 

 

 

Locations 

THE LOCATIONS LIST SCREEN 

The layout of the aisles, bays and 
shelves throughout your record center 
is input at the Locations List screen. 
You may have multiple locations 
(buildings), several floors in one or 
more of the buildings, mezzanines, 
etc. This information is displayed in 
the Locations List (right). 

To access this screen, click Maintain 
> Locations on the Menu Bar. 

Filters – Several filters are available 
here, and may be used in 
combination. 

 

 

     

entering a beginning location in the Location box and an ending location in the To box. 
 Box Size – This is a pull down menu of the box sizes in your master file. 
 Open Spaces Only – The filter will display only those shelves with open spaces. 

For example, if you wanted to display all the open archive carton shelves for Isle A on the 14th floor of 
a building, you would put 14-A in your filter.  

Remember that your query results can be sorted by clicking on the bar at the column heading. 

Location – You may enter all    Fig.19 
or part of a location using the  
wildcard character %. Or   
you may request a range by…  
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 Name – the box size code name is automatically 
obtained from the Box Size Code table. 

 Filled Spaces – a count of currently occupied 
spaces. 

  

 #1

A-01-AA-1-A

#2
#3
#4

Position

#5

THE CURRENT LOCATION SCREEN 

Locations are edited at the Current 
Location Screen (Figure 19). To enter this 
screen from the Location List Screen, 
either highlight the desired code and click 
Edit, or simply double-click the code you 
wish to edit.  

In this illustration, 4 of the 8 available 
spaces are occupied. 

Each Location Master will contain: 

 Box Size Code – this may be pulled 
down by using the tab to the right or 
typed in.  

 Open shelf – used for folders & tapes 
stored open without a box. 

 Location Code – 11 places, numbers 
and letters. 

 Maximum Space on Shelf – 3 places, numbers only.    Fig.20 
 
 
   

 

 Empty Spaces – a count of currently unoccupied spaces. 

NOTE: RMS works closely with each Archive Manager user to establish a scalable but easy to 
use Location Code numbering scheme for their particular business.  

Location Codes can be designed to contain all your pertinent location information; for example, the 
building, floor, aisle, bay and the shelf within the bay, depending on your business requirements. The 
Location Code field is sufficient in size to accommodate most location codes schemes. It is a good 
practice to use dashes (-) to separate key elements of the location code.  

An example of a typical Location Code configuration is as follows:  

Location Code =   
 

 

 

 

 

 Fig. 21 

In this hypothetical implementation: 

Position #1 represents the building number or code. 

Position #2 represents the floors. 

Position #3 represents the aisles.  

Position #4 represents the bays down an aisle. 
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Position #5 represents the shelves in a bay.  

Remember - this is just an example. In most cases, your existing numbering scheme will be useable 
as-is. 

Archive Manager can accommodate storage of up to 99 containers on any one shelf. If you are storing 
more than 99 containers on a shelf, you will need to define that location to Archive Manager as two 
shelves. 

Incidentally, you can see from this example why it is crucial to enter Master Box Size Codes before 
entering client information; 

Creating Locations From Spreadsheets 
Using the import Excel spreadsheet typically located in C:\Program Files\RMS\Archive 
Manager\Settings you can import locations. This is very useful for mass entering locations. 
 
The Excel File is Import_Location.xls 
Columns 
 Location – location code 
 Box_Size – box size code (must be set up in Archive Manager first) 
 Max_on_Shelf – maximum number of spaces 
 
 
On the top of the Maintain Locations list click Import. Navigate to the folder where you have saved 
Import_Location.xls and double click it or highlight it and click Open. Your locations will import into 
Archive Manager. 
 

Industry Codes 

THE MAINTAIN INDUSTRIES SCREEN 

To access the Maintain Industries 
Screen (right), click Setup > Industry 
Codes on the Menu Bar. 

This table contains a list of FTC 
industry codes. You can edit the list or 
add additional codes. 

Filters – You may put any code or 
name into the filter boxes and click the 
Filter button to search for an industry 
code. 

 

 Fig. 22 
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THE CURRENT INDUSTRY SCREEN 

Industries on the list can be edited, or 
additional industries added, at the 
Current Industry Screen. To enter this 
screen from the Maintain Industries 
Screen, either highlight the desired 
industry and click Edit, or simply 
double-click the industry you wish to 
edit.  

 

 

 Fig. 23
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Chapter 3 – Setting Up Customers 
ENTERING AND MAINTAINING CLIENTS 

The client Information that is entered in Archive Manager is stored in the Client File. This is a key file in 
Archive Manager in that it contains all the critical information pertaining to each client.  

You will be entering information regarding: 

 address, city, state and ZIP 
 billing address, city, state and  

ZIP 
 telephone numbers, business, fax, 800 number, etc. 
 email and Web addresses 
 contract 
 storage and service rates 
 tax-exempt status   Fig 24 

THE MAINTAIN CLIENTS SCREEN   

 

 

 

 

 

 

To view a specific client, enter one or more 
criteria and click the Filter button. Or, to select a client from the full list of clients, simply click the Filter 
button without entering any criteria to see the full list. 
Filters 

 Code – client code 

 Name – client name 

 City – city 

 Active – click checkbox filter to select: 
All Clients, Active Clients, or Inactive 
Clients 

THE CURRENT CLIENT SCREEN 

Individual clients are edited at the Current Client 
Screen. To enter this screen from the Maintain 
Clients Screen, either highlight the desired 
client and click Edit, or simply double-click the 
client you wish to edit. 
  

 Fig. 25 

The information you will need to find 
your clients in the Archive Manager 
system is displayed on the Maintain 
Clients Screen (right).  

To access this screen using the Menu 
Bar, click Maintain > Customers. Or, 
using the Task Pane, click the  
Maintain tile then the Customers 
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Client data can be exported directly into QuickBooks using the Accounts Export Utility described in 
Chapter13. 
The Current Client Screen displays the following fields: 

 Code – a 10 position alphanumeric identifier for the client company. 
 Industry – the FTC Industry Code; may be entered by typing or selecting from pull-down list. 
 Name – the client company’s business name. 
 Active – click this box if this is an active client. 
 Email – the main contact’s email address (additional email addresses will be added later in this 

process). Note this email address will be used to send PDF invoices. See Chapter 11 End Month 
Billing. 

 Email (2) – second email for PDF invoices 
 Web – the client company’s Web address. 
 Address – the client company’s street address - 2 lines are provided.  
 City – the client company’s city. 
 State – the client company’s state; may be entered by typing or selecting from pull-down list.  
 Zip – the client company ZIP; configured for 9 digit zip codes. 
 Phone – the client company’s phone number. 
 Fax – the client company’s fax number. 
 Phone (2) – the secondary phone number (such as primary contact’s direct phone number). 
 Toll Free – the client company’s toll free phone number. 
 Billing Contact – the person to whom bills are addressed. 
At this point, if the billing address is the same as the main address, then just click Same as Main. If 
not, continue filling in the billing address fields.  
Once you have completed this form, it is important to continue with other pertinent information about 
this client by clicking the buttons at the bottom of the form. 

THE CUSTOMER CONTRACT SCREEN 

Click the Contract button to access the 
Customer Contract Screen (right), which 
contains the following fields: 

 Departmental Billing – check this box if 
departmentalized invoicing will be used. 

 Departmentalized client - check this box 
for departmentalized reporting. 

 Tax-Exempt – check this box  
if the client is tax-exempt. (Be sure to obtain 
an ST-5 form for your records.) 

 PDF Invoice – check this box if the client 
will receive PDF invoices via email. 

 

 

 Fig. 26 
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 Storage Will be Billed – select billing period from the pull-down menu (default is monthly). 
 Fees Based On – select Per Box or Per Cubic Foot from the pull-down menu (default is Per Box). 
 Billing Representative – client’s billing contact at your company.  
 Contract/PO Number – the contract or purchase order reference number. 
 Invoice Terms – when and how payment is expected from client, as per contract. 
 Contract Begins On – beginning date of contract. 
 Contract End On – termination date of contract. 
 Minimum Storage Fee – if not blank, storage charges totaling less than the indicated amount will 

be adjusted up to this amount. 
 Tax Rate – sales tax rate on taxable items, expressed in decimal form; i.e., a sales tax rate of 

6.25% would be entered as .0625. 

 IMPORTANT: Remember each time you complete this form to press the Continue button to save 
your entries. 

THE CONTACT SCREEN 

Click the Contact button 
on the Current Client 
screen to access the 
Contact List. Click Add or 
Edit on this screen, and 
the Contact Screen 
appears (right, 
foreground), where you 
can add a new contact for 
the customer, or enter 
details for the current 
contact.  

The User Name will be 
the same as the User 
Name for the Web 
Access software, and the 
Password will be the Web 
Access software 
password. 
 

  

 Fig. 27  

WEB ACCESS PASSWORDS 

For information about Web Access Software or for a Web Access Password, see Appendix C in this 
Guide. 
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 Code – a 10 place field with  
numbers and letters for the 
department code. 

 Name – the department name 

Clients With Departments 

THE CLIENT DEPARTMENTS SCREEN 

On the Current Client Screen (Fig. 25, above), click the Department button to access the Department 
Screen for the current client (right).  

Click Edit to modify an existing 
department, or Add to add one. 

The fields are as follows: 

 Client – the current  
client’s name 

 

  
 

 Fig. 16 
 

To edit individual departments, just as with the previous detail screens, you can click Edit, or double 
click the desired department.          Fig. 28 

THE DEPARTMENT DETAIL SCREEN   

The Department Detail Screen is where the 
department information is recorded – with the 
exception of contacts.  

Clicking the Contacts button on this screen 
accesses an additional screen, the Department 
Contacts List Screen (Fig. 30, background, below), 
where your department contacts are listed. 

 

 Fig. 29 
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THE DEPARTMENT CONTACT SCREEN 

Click Add or Edit on this 
screen, and the 
Department Contact 
Screen appears (Fig. , 
foreground), where you 
can add a new contact for 
the current department, 
or edit information for the 
current contact.  

The User Name will be 
the same as the user 
name for the Web Access 
software, and the 
Password will be the Web 
access software 
password.  

 

 

 

 Fig. 30 

 NOTES: Contacts entered at the Departmental Contact screen will have access only to Web data 
for the current department.   
 
To allow a user to access Web data for all departments, enter the Contact at the NON-
departmental Contacts screen (Page 18). Contacts entered at that screen have global access to 
Web data for all departments. 

WEB ACCESS PASSWORDS 

For information about Web Access Software or for a Web Access Password, see Appendix C in this 
Guide. 

 

Additional Setup Details 

THE BOX SIZES LIST SCREEN 

Referring to Fig. 31 at right, a detail 
from the Current Client Screen, click 
the Box Sizes button to access the 
Box Sizes List Screen (Fig 32. , below).  

  

  
 Fig. 31 
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The Box Sizes List Screen employs 
the master Box Size Codes you 
entered during your initial set up. 
Use this screen to edit the Box Size 
Code Rates, or to add additional 
codes for this client.  
 
 

 

 Fig. 32 

 

 

 

THE BILLING CODES LIST SCREEN 

 Referring again to Fig. , above, from 
the Current Client Screen, click the 
Billing Codes button to access the 
Billing Codes List Screen (right). 

The displayed list employs the 
master Billing Codes you entered 
during your initial set up. Use this 
screen to edit the Billing Code Rates, 
or to add additional codes for this 
client.   
 Fig. 
173 

 
 

FIXED AND CURRENT CHARGES 

Two additional buttons in the detail illustration above are for Fixed Charge, and Current Charge. 
These buttons access the Charge Entry Screen, which is discussed in Chapter 10, Billing. Charges  
 
Filter – You can use the filters to bring up clients of a specific code, name, and/or city. This may be 
used individually or in combination. Again, the query results may be sorted by clicking on the column 
heading. 

Exporting to QuickBooks 
Once you have entered client data in Archive Manager, there is no need to manually re-enter it into 
QuickBooks; just export it into QuickBooks from Archive Manager.  

EXPORTING CLIENTS TO QUICKBOOKS 

Clients can be exported to QuickBooks using the Accounting System Export screen. For details about 
this feature, see Exporting Invoices to QuickBooks (and Other Accounting Packages) in Chapter 13. 

QuickBooks, export to 
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 IMPORTANT: Archive Manager can export any particular record to QuickBooks only once. 
Before exporting records, make sure that they are complete and accurate! Corrections in 
QuickBooks can be made only manually. 

 

THE UTILITIES BUTTON 

When the Bill To field for a client is empty, any attempt to export that record will cause a blank client 
record to be exported to QuickBooks. Client record, blank 

When you are aware that this field is empty in one or more records you intend to export, proceed as 
follows:  

 If working in the Maintain Clients Screen, highlight the desired records.  
 Right-click anywhere on the gray area to access the action menu.  
 Select Utilities, then Same as Main.  
This forces Archive Manager to disregard any empty Bill To fields while exporting the selected 
records.  

 

INACTIVE CLIENTS 

When you flag a client as inactive by unchecking the Active client box in the current client edit screen, 
you can no longer add boxes, folders, tapes, or charges for this client. Note by default all new clients 
entered into Archive Manager are checked as Active. 
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Chapter 4 – Record Titles 
Record Titles are used by Archive Manager to identify groups or categories of records belonging to a 
given client. For example, a law firm might use Record Title RE to represent real estate closings. 
Record Title data can be used to calculate destruction dates to implement retention schedules for 
each client. 

THE SETUP RECORD TITLES SCREEN 

To access the Setup Record Titles Screen 
(right), open the Maintain Panel on the 
Activity Pane and choose Record Titles. 
Or, on the Menu Bar, click Maintain > 
Titles. 

The Client field on this screen serves as a 
filter, limiting the display to Record Titles 
of the specified client. 

The active filter works as described in 
clients 

To add a new item, Click the Add button 
to access the New Record Titles Screen. 
 
 Fig. 34 

 

 

THE NEW RECORD TITLES SCREEN 

The New Record Titles Screen (right)   
employs the following fields:  

 Client – Client Code may be 
selected from pull down list or 
entered manually. 

 Record Title – Enter client’s Record 
Title Code for this item. 

 Active Record Title – click this box if 
record title is active (checked by 
default) 

 Retention Date – Retention Period 
for this item in years and months. 

 Description – Unlimited text 
description of the Record Title item. 

 Regulation - Unlimited text detailing 
the regulation for this item.                        Fig. 35 

 Apply Retention Date on Items button – Click this button is to update the Destruction Date for 
all boxes and folders for a client whose retention period has been up dated.   
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THE CURRENT RECORD TITLES SCREEN 

Titles of existing records may be edited in the Current Record Title Screen, below. To bring up a 
record title on this screen, highlight or double-click it in the Setup Record Titles Screen (Fig. 35, 
above).  
 
When you are finished making your 
changes in a field, Tab to the next field to 
save your changes. The Tab key also 
activates the Save button. 
   
 
 
  
  
 
 
 
 
 Fig. 36 

 
 
 
 
 
 
 

INACTIVE RECORD TITLES 

When you flag a record title as inactive by unchecking the Active Record Title box in the current record 
title edit screen, you can no longer use this record title for boxes. Note by default all new record titles 
entered into Archive Manager are checked as Active. 
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Chapter 5 – Boxes 

About Boxes and Folders 
Archive Manager tracks boxes according to their assigned Box Number and storage location. Folders, 
however, are tracked according to the boxes in which they reside. They therefore share the unique 
Box Number of that box, followed by a Folder Number of between 1 and 999.  Boxes and Folders, 
about 

Some of your customers will be interested primarily in box storage and retrieval, while other will be 
concerned with individual folders. For example: 

 a company controller made need to review all the general ledgers in a box, while  
 an attorney may need to see the file containing a real estate closing.  
Some customers may even have departments with differing needs. Archive Manger makes it possible 
for your record center to provide not just storage, but individualized record management services to 
every type of customer. 

Box Storage Customers Folder Storage Customers 

Examples: 

 Securities firms (brokerage) 
 Investment banks 
 Sales firms 
 Manufacturing 
 Banks 

Examples: 

 Law firms 
 Accountants 
 Insurance Companies 
 Medical offices 

For box storage customers, beyond the basic 
box description, there are two ways of 
recording additional details: 

1. Create fictitious folders to describe the box 
or it contents in greater detail, or 

2.  Use the Comments field to record 
additional details.  

 

Typical folder descriptions for folder customers:  

 Major – a client or patient 
 Minor – the subject matter 
 Matter No. – a file or client matter no. 
 

Available Reports:  

1. Box content report, which includes folders, 
2. Box inventory report with parameter 

include text = Yes 

Available Reports:  

1. Folders Inventory.  
2. Box inventory report ordered by ranges (if 

all the folders in a box are numeric ranges)  
3. Boxes W/O Folders report. 

 Filtering: yes 
 Lists: yes 

 Filtering: yes 
 Lists: yes 

 Maintaining Stored Boxes 
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Maintaining Stored Boxes 

THE MAINTAIN BOXES SCREEN  

The Maintain Boxes screen displays the 
status of stored boxes and provides 
access to sub-screens for various box 
management activities. To access this 
screen, click the Maintain Tab on the 
Activity Pane to select the Maintain 
Panel, and then click Boxes. Or, you 
may click Maintain > Boxes from the 
Menu Bar.  

The status of each box is represented 
by a Box Status symbol in Column 1 of 
the display. The symbol meanings are 
as follows:  
 Green dot – box is currently in the 

record center 

 Gray left arrow – box has been 
checked out 

 Blue dot with red X – box has been 
destroyed.                           Fig. 37 

 Gray hollow right arrow – box has permanently been removed 
 Yellow/gray dot – box has been requested for check out via Web Access.  

The filters on this screen are as follows: 

 Box number – (Required) 9 position numeric field. Numbers may be entered automatically by 
clicking the Last Box # button, or may be entered manually. 

 To – You can enter a box number to to filter on a range of box numbers. 
 Description – 50 character alphanumeric field that can be used to describe the contents of the 

box.  
 Client – Client Code, a 10 position alphanumeric field. Click the Ellipse Button to select the code 

from a list, or enter it manually. When field is populated, the client’s full name appears in the box 
to the right. Click the Exact match box to match the client code exactly. 

 Department – Department Code, a 10 position alphanumeric field. Click the Ellipse Button to 
select the code from the Client Master List, or enter it manually. 

 Range – a numeric file number which will display boxes in that set of values. 
 Legal Hold – click checkbox filter to select boxes on legal hold. 
 Cross References – Click the Cross 

Reference button to access the Box Cross 
Reference List (right). You may add 
unlimited cross references, typically box 
numbers.  

 Note that only the first cross reference is 
displayed on the any of the box edit 
screens. All cross references are 
searchable, however.          Fig. 38                                     

 

 



 

Chapter 5 – Boxes  Page 28 

Search page #2 

   Fig. 39 
 

The fields on Search page #2 are as follows: 

 Choose A List – Allows you to select an existing list. (When you use a filter, the resulting 
selection can be saved to a list that you can use to access those items quickly. For an explanation 
of List and how to use them in Archive Manager, see Chapter 7 – Lists.)  

 Location – Filter: enter a specific location to limit your search to that location.  

 NOTE: Because storage spaces are reserved for specific box sizes, the Box Size and Space 
Number on storage shelves are entered automatically when you choose the location. Therefore, 
box sizes must never be mixed on a single shelf; i.e., boxes of each size must only be placed on 
shelves reserved specifically for that box size.  

 Status – Pull down filter containing a scroll menu. The menu gives you a choice of: 
 All boxes 
 Checked Out boxes 
 Boxes in record center 
 Requested by All Users boxes 
 Requested by Current Users boxes 
 Requested from Web Access boxes 

 Destroyed - Pull down filter containing a scroll menu. The menu gives you a choice of.: 

 Live boxes 
 All Boxes 
 Destroyed boxes 
 Permed out boxes 

 Comments – unlimited additional text. 
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Search page #3 

Fig. 40 
 
The fields on Search page #3 are as follows: 

 
 From date – click select to bring up the calendar to select the box from date. 
 To date – click select to bring up the calendar to select the box to date. 
 Received date – click select to bring up the calendar to select the box received date. 
 Destroy date – click select to bring up the calendar to select the box destroy date. 
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Editing Box Information 

THE CURRENT BOX SCREEN 

If you need to locate a box for editing, 
using filters in any of the box screens 
is a quick way to find it. 

Once the box is on your screen, to 
edit the Box Information from any 
screen, you can either  
 select the box and click Edit, or  
 double-click the box  
to open the Current Box Screen 
(right).   

 

 

 Fig. 41 

Simply enter or change the desired information, add folders or cross references, and click Save. The 
fields with asterisks are required fields and are described along with any fields which were not 
previously described, below. 

 Client – (required on this screen).  
 Received – (contains the current date by default) Date field showing the date box is received into 

record center.   
 Destroy – (contains 12/31/9998 by default) Date field indicating the month, day, and year this box 

is eligible for destruction. Archive Manager interprets the default date 12/31/9998 to mean 
permanent. 

 From Date – Date field used in conjunction with the To Date field to describe the time interval 
covered by box contents. 

 To Date – Date field used in conjunction with the From Date. 
 Ranges – Range of file numbers that can be used to describe a sequence of files stored in the 

box.  
 Record Title – After Record Titles have been set up (see Chapter 4), click the Ellipse Button to 

select a value from the Record Title List. 
 Media – Click the Ellipse Button to select a Media Code from a list, or enter it manually. 
 Comments – An unlimited text field for additional information about a box. Word documents or 

spreadsheets can be pasted here. 
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 Folders – To add, edit, or search 
folders for a particular box, click on 
the Folders button in the Current 
Box Screen (Fig.41 , above) to 
access the Folders List Screen 
(right). For more information about 
managing folders, see Chapter 6 – 
Folders. 

   
   Fig. 42 
 

 
 
 
 Tapes – To add, edit, or search 

tapes for a particular box, click on 
the Tapes button in the Current 
Box Screen (Fig.41 , above) to 
access the Tapes List Screen 
(right). For more information about 
managing tapes, see Chapter 7 – 
Tapes. 

 
                                                Fig. 43 
 
 
 
 

Entering New Boxes 
New boxes may be entered into Archive manager in either of two ways; either  
 manually, or 
 using a Portable Bar Code Reader. 
While it is possible to handle large numbers of boxes without the use of bar coding, bar coding greatly 
reduces handling time and likelihood of error. The RMS Portable Bar Code Reader has advanced 
ergonomic features, is extremely cost-efficient, and is highly recommended. 

While this chapter deals with boxes both with and without bar code labels, detailed instructions about 
the use of the RMS Portable Bar Code Reader will be found in Chapter 19, The Portable Bar Code 
Reader. 

After you have entered the setup information described in Chapters 2 and 3, you are ready to begin 
entering client’s boxes. You cannot begin this process before this point. 

Receiving and Stowing Bar Coded Boxes 
This process assumes that a bar code label has been attached to the front each arriving box. Labels 
must generally be printed before the pick up, and can be placed on the boxes either by the client, or 
by your driver at your or the client’s location. 
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Entering Bar Coded Boxes Manually 

THE NEW BOX SCREEN 

Boxes are entered into the Archive 
Manager system using the New Box 
Screen (right). To access this screen, 
press the Add button on The Maintain 
Boxes Screen (Fig. 25, above). 

Fields on this screen with asterisks are 
required fields. 

You can add folders at the same by 
pressing the Folders button. To see 
information about how to enter folders, 
see Chapter 6, Folders.  

After filling the fields on the screen, 
click either the Save&Add button or 
the Save button.        

                                            Fig. 44 

  

  

Checking Boxes In and Out Manually 
Boxes may be checked in or out either of two possible ways: 
 automatically, using the RMS Portable Bar Code Reader to scan data, or  
 manually, using Archive Manager’s Box Check Out Screen (Fig. , below).  

Use of the RMS Portable Bar Code Reader is discussed in Chapter 19; the present discussion will 
deal only with Manual check in and check out. 

Manual check in or check out may be performed individually by box or groups.  

Check In or Out Single boxes 

THE BOX CHECK IN/OUT SCREEN 

Select a box on the Current Box Screen 
(Fig. 40, above). Click the Check In or 
Check Out button to access the Box 
Check In/Out Screen (right).  

Fill in the fields on this screen as follows: 
 Name (required) – person placing 

order. 
 Phone – phone number  

of person placing order.  
 
Fig. 45 
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 Address – the address where box(es) should be picked up or delivered, as specified by customer.  
 Ticket # (required) – the ticket or work order number. 
 Check Out – the date of work (default: current date). 
 Return By – the date of expected return (default: current date plus 30 days).  
 Check in – the actual date of check in (default: current date). 
 Comments – an unlimited alphanumeric text field.  
 Insert Charges – see below, on this page.  

Check In or Out Multiple boxes 
There are two possible ways of checking multiple boxes in or out: 

 Selecting multiple boxes for immediate check in/out 
Using either a previously created list or the Maintain Boxes Screen (Fig. 25, above), select a 
group of multiple boxes, then right-click and choose check in or check out. Then use the Box 
Check In/Out screen to immediately check in/out boxes. 

 Marking a selection of boxes for check in or check out 
Select from a list or the Maintain Boxes Screen as above, then right-click the selection and choose 
Request for Checkout. This will mark the selected boxes in yellow, but will not bring up the 
Checkout Screen immediately. You can then filter the requested items to a list, Select All, and 
then right-click to check items in or out. 

To remove an item from the above list, right-click it and select Remove from Current List. 
If the list includes items belonging to multiple clients, when you select Check Out from the action list, a 
new Box Check In/Out Screen will be displayed for each client.  

THE CHARGE SCREEN 

Insert Charges – During a check in/out 
operation, whenever this box is checked, 
the Charge Screen (right) will appear 
after the Check Out button is clicked. This 
screen is similar in function to the New 
Charge Screen, which will be discussed 
in Chapter 10, Billing, and allows you to 
create billing “on the fly”.

  

 Fig. 46 
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Destroying or Removing Single Boxes 
 The Box Destruction process indicates to Archive Manager that a single box or group of boxes is to 
be destroyed or permanently removed from storage. Boxes may be destroyed individually or in groups. 

THE REMOVE/DESTROY DIALOGUE SCREEN 

While viewing a box on the Current 
Box Screen, click the Destroy or 
Permanent Out button to access the 
Remove/Destroy Dialogue Screen.  

The dialogue box contains the 
following fields: 
 
 

 Fig. 47 

 Name (required) – the person authorizing destruction or permanent removal.  
 Date – the date of the transaction (defaults to today’s date). 
 Ticket # (required) – the ticket or work order number. 
 Insert Charges – click the box to create billing for this activity. 

If the Insert Charges  the New Charge screen appears (see Chapter 10 – Billing) and the billing can 
be generated “on the fly”. 

Destroying or Removing Multiple Boxes 
In the Maintain Boxes Screen (Fig. 35), either use an existing list, or select a group of boxes. Right-
click the selection and select Destroy Boxes or Permanent Out, as desired, from the action list.  

If desired, click the Insert Charges box to create billing for this activity. 

After permanently removing or destroying boxes, it is important to run the Destruction Process 
Reports: 

 Certificate of Destruction Report 
 Destruction Summary Report 
 Destruction Pull List 
 Destruction Empty Spaces Report 
These are described in detail in Chapter 14, Reports 

UTILITIES 

When multiple items are highlighted in the Maintain Boxes Screen, right-clicking accesses a Utilities 
Menu. The use of these utilities is discussed in Chapter 18, Utilities. 

 

Legal Hold 
If a box is on legal hold, then it cannot be permanently removed, destroyed, or deleted. It can be 
edited, checked out, etc. A user with full rights to edit boxes can place boxes on legal hold; however 
only the superuser password can remove boxes from legal hold. 
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 Boxes can be placed on Legal Hold via 2 methods:  
1. By editing a box and clicking Legal Hold button on bottom right. After placing on Legal Hold, the 
check box will appear in the Box Edit screen. 

2. Or filter a list of boxes and right click and choose Put on Legal Hold. 

 

In both cases after selecting boxes to put on legal hold a dialogue box appears 
   
Field explanations 
Date on hold - date field  
Who put on hold – 20 characters 
Legal matter No. – 5 lines   - 20 
characters - only first line required 
 
 
Fig. 48 
 
 
 
 

If a box is on Legal Hold, the Legal Hold button will be checked. You can see who put a box on legal 
hold by clicking the Legal Hold button in the box edit screen 
 
To remove a box or boxes from legal hold, either: 
1. Edit a box and click the Legal Hold button, which pops up the dialogue box and click Remove Legal 
Hold 
2. Right click and choose Remove from Legal Hold. 
Note – Only the superuser password can remove boxes from Legal Hold. 
 
Note - if a box or boxes are on Legal Hold you 
will receive a warning that these boxes cannot 
be destroyed or permanently removed when 
trying to perform those operations.      Fig. 49 
 
 
 
There is a report available for boxes on legal hold in the base group of reports. 
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Chapter 6 – Folders 

Maintaining Stored Folders 

THE MAINTAIN FOLDERS SCREEN  

The Maintain Folders Screen 
(right)  displays the status of 
stored folders and provides 
access to sub-screens for 
various folder management 
activities. To access this screen, 
click the Maintain Tab on the 
Activity Pane to select the 
Maintain Panel, and then click 
Folders. Or, you may click 
Maintain > Folders from the 
Menu Bar.  

  

 Fig.50 

The status of each folder is represented by a Folder Status symbol in Column 1 of the display. The 
symbol meanings are as follows:  

 Green dot – folder is currently in the record center. 
 Gray left arrow – folder has been checked out. 

 Blue dot with red X – box has been destroyed. 

 Gray hollow right arrow – box has permanently been removed 
 Yellow/gray dot – box has been requested for check out via Web Access.  
 Blue dot – box containing this folder has been checked out. 
This screen is similar to the Maintain Boxes Screen and contains many of the same fields, but the 
fields are mapped specifically for folder information. 

The filters on this screen are as follows: 

 Major – (50 characters alphanumeric) general description of folder (i.e., ABC Co. vs. XYZ Co.) 
 Minor – (50 characters alphanumeric) Detail of folder contents (i.e., Depositions for ABC Co.) 
 Matter # - (20 characters alphanumeric) typically the file number 
 Client Code – Client’s identifier code – click Exact Match to match the client code exactly 
 Department code – Client’s department identifier code 
 Box number – 9 position numeric field. This refers to the box containing the subject folders. 
 Location code – the location of the folder 
 Cross reference – cross reference 
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Search page #2 

  Fig. 51 
The fields on Search page #2 are as follows: 

 Choose A List – Allows you to select an existing list. (When you use a filter, the resulting 
selection can be saved to a list that you can use to access those items quickly, as explained in 
Chapter 7 – Lists.) The quickest way to find a specific folder on this screen is by filtering a list. 

 ID – (20 characters alphanumeric) usually a partner’s name or initials. 

 Comments – unlimited additional text. 
 Status – Pull down filter containing a scroll menu. The menu gives you a choice of: 

 All folders 
 Checked Out folders 
 Folders in record center 
 Requested by All Users  
 Requested by Current Users  
 Requested from Web Access  

 Destroyed - Pull down filter containing a scroll menu. The menu gives you a choice of.: 
 Live folders 
 All folders 
 Destroyed 
 Permed out 

Search page # 3 
 

Fig. 52 
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 Department – (10 position 
alphanumeric) department code, 
which may be entered manually or, 
by clicking the ellipse, from the pull 
down list. 

 Folder Number – (four digits) 
populated automatically, but may 
be changed manually. 

The fields on Search page #3 are as follows: 

 
 From date – click select to bring up the calendar to select the folder from date. 
 To date – click select to bring up the calendar to select the folder to date. 
 Received date – click select to bring up the calendar to select the folder received date. 
 Destroy date – click select to bring up the calendar to select the folder destroy date. 
 

Entering new folders 

THE NEW FOLDER SCREEN 

To enter new folders, click the Add 
Button to access the New Folder Screen 
(right). This screen contains the following 
fields (the fields marked with asterisks are 
required): 

 Box Number – may be entered 
manually or, by clicking the ellipse, 
from the pull down list. A current valid 
box number must be entered, as 
folders are a subset of the boxes that 
contain them. 

 Company – Client Code, 
automatically populated when the box 
number is entered. 

 
 
 
 
 Fig. 53 

 
 
 NOTE: Because each box has unique folder numbers, the Add Folder Screen cannot be saved if a 

duplicate folder number is manually entered.. 

 ID – (10 position alphanumeric) typically, the last name or initials of the person responsible for this 
folder, such a manager or corporate officer in the client company. 

 Matter # – 13 characters alphanumeric) Case Numbers (Law Firms), Patient Numbers (Hospitals), 
Claim Numbers (Insurance Companies), etc. 

 Received Date – (date field) date folder is received into the record center. 
 Destroy Date – (date field, automatically populated from box data) month, day, and year this 

folder is eligible for destruction. 
 From Date – (date field) used in conjunction with To Date to indicate time period of the records in 

folder. 
 To Date – as described above. 
 Major Description – a general description of folder.  
 Minor Description – a detailed description of folder contents. 
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You can add unlimited cross   
references, which are typically  
client’s file numbers. Only the 
first cross reference is displayed 
on the Folder Edit Screen, but all 
the cross references are 
searchable. 
 

 Comments – (unlimited text field) use to input additional information about the folder; you can 
paste Word documents or spreadsheets here. 

 Location Code – the location of box containing this folder automatically populated from box 
information. 

 Space on Shelf – the code for specific space occupied by box. 
 Folder is In/Out – reports whether folder is currently in the recorder center.  
 ID – initials or last name of the client representative responsible for the folder. 
 Box # – box number(s) in which the subject folder(s) are stored. 
 Matter # – the client’s file number 
 Client Code – as previously explained 
 Cross Reference – press this 

button to access the Folder Cross 
Reference List (right). 
Cross referencing is used when a 
box or folder is known by more 
than one reference number. This 
can occur, for example, when your 
record center absorbs boxes from 
another center, or needs to 
renumber the customer’s boxes for 
any reason.   
 
 

 

 Fig. 54 

 

 Filtering – applies a filter to your list. Folders can be filtered just like  
boxes, with single or multiple filters.  

 An example of the use of multiple filters would be if a law office set the Client filter = LEVEN, the 
Major filter = OPEL, and the Minor filter = REAL ESTATE, to find the Opel Industries Real Estate 
Closing for customer Leven. 

Remember that the wildcard character is %. As with all Archive Manager lists, query results may be 
sorted by clicking on the column heading.   
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THE CURRENT FOLDER SCREEN 

Folder information is edited on the 
Current Folder Screen (right). To edit 
a folder on this screen, either double 
click the folder on the Maintain 
Folders Screen (Fig. 50, above), or 
select it and click Edit. A quick way 
to find a specific folder on the 
Maintain Folders Screen is by 
filtering a list.  
The fields and field descriptions on 
the Current Folder Screen are 
identical to those on the New folder 
Screen, Fig.53, above. 
 Fig. 55 

 

 

Checking Folders In and Out 

THE FOLDERS CHECK IN/OUT SCREEN 

Click the Check Out button on the 
Current Folder screen to access the 
Folders Check In/Out Screen. 

This screen is identical in 
functionality to the Boxes Check 
In/Out Screen (Chapter 5, Fig 45. ). 
The process for checking folders in 
and out is identical as well. See 
Chapter 5 for a review of the subject.  
 
  
 
 Fig. 56 

THE FOLDER DESTRUCTION PROCESS 

The Folder Destruction process indicates to Archive Manager that a single folder or group of folders 
is to be destroyed or permanently removed from storage. However, since storage fees are not charged 
for folders but only for the boxes that contain them, folders are usually not destroyed individually but 
rather, along with their boxes. The screens and processes used for destroying folders are identical to 
those for boxes. Please see Chapter 5, The Box Destruction Process, to review the procedures. 
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Move folders utility 

Step 1 - Click Move Folder on the far top right of the 
Maintain Folders list and the Step 1 dialogue box 
appears. Fill in a box number and a folder number. Then 
click OK. 
 
Fig. 57 
 
 
 
 
 
 
 
 

 
 
 
 
Step 2 – This is a confirmation that you have selected the 
correct folder. If so, click OK. 

Fig. 58 
 
 
 
 
 
 
 
 
 
 
Step 3 – Enter the box number that the folder is being 
moved to. Archive Manager will automatically assign the 
next available folder number in that box to this folder. Then 
click ok and you will then see a pop up message that the 
folder has been successfully moved.   Fig. 59 
 
 
 
 
 

 Fig. 60 
 
If you wish to move additional folders, click OK. 
 
If you continue to move folders, Step 3 will remember the last box number that you wish to move 
folders to. If this folder is for the same box, just click OK. Or change the box number. 
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Folder Checked Out – If a folder is checked out, a warning will pop up asking if you want to check it 
in. If you click Yes, then the standard Archive Manager check in dialogue box will appear. This will also 
update the Audit Trail in the tab Folder I/O. 
 
 
 
Folder Destroyed or Permed Out – If a folder is destroyed or permed out, a warning will pop up 
asking if you want to recall it in. If you click Yes, then the folder status will be updated to live. This will 
also update the Audit Trail in the tab F History. 
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Chapter 7 – Tapes 

Maintaining Tapes 

THE MAINTAIN TAPES MODULE  

To access the Maintain Tapes module, click the Maintain Tab on the Activity Pane to select the 
Maintain Panel, and then click Tapes. Or, you may click Maintain > Tapes from the Menu Bar.  

Search page #1 

 
 

Fig. 61 

 

The Maintain Tapes module consists of three screens or pages. These screens display the status of 
stored tapes, and provide access to sub-screens for various tape management activities.  

Upon opening, the Maintain Tapes module defaults to Search page #1 (above). The status of each 
Tape is represented by a Tape Status symbol in Column 1 of the display. The symbol meanings are as 
follows:  

 Green dot – Tape is currently in the record center. 
 Gray left arrow – Tape has been checked out.   
 Yellow dot – Tape has been requested for check out.  
 Blue dot with red X – Tape has been destroyed  
 Gray right arrow – Tape has been permanently removed 
 Blue dot – box containing this tape has been checked out 
This screen is similar to the Maintain Folders Screen and contains many of the same fields, but the 
fields are mapped specifically for Tape information. 
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The fields on Search page #1 are as follows: 

 Client Code – Client’s identifier code. – Click Exact Match to match the client code exactly. 
 Minor – (50 characters alphanumeric) Detail of Tape contents (i.e., Depositions for ABC Co.) 
 Dept code – A client’s department code 
 Major – (50 characters alphanumeric) general description of Tape (i.e., ABC Co. vs. XYZ Co.) 
 Location code – Location of the tape 
 Box number – Reference number of box containing the subject Tapes. 
 Tape number – Reference number of tape 
 Box size code – Code indicating size of above box 
 Next rotation date – the next scheduled rotation date (a date picker tool appears when you click 

the checkbox). 
 Tape type - nomenclature for tape (i.e. MT or Mag Tape for Magnetic Tape) 
 Cross reference – cross reference 

Search page # 2 

 
Fig. 62 

The fields on Search page #2 are as follows: 

 Choose A List – Allows you to select an existing list. (When you use a filter, the resulting 
selection can be saved to a list that you can use to access those items quickly, as explained in 
Chapter 8 – Lists.) The quickest way to find a specific Tape on this screen is by filtering a list. 

 ID – tape ID 

 Comments – unlimited text field 

 Status – Pull down filter containing two scroll menus. The upper menu gives you a choice of: 

 All Tapes 
 Checked Out Tapes 
 Requested by All Users Tapes 
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 Requested by Current Users Tapes 
 Requested from Web Access Tapes 

 Destroy status – live tapes or all tapes 
 Ordered items – tapes from unprocessed orders or all tapes 
 Rotation tapes – today’s items or all  
 

Search page # 3 

Fig 63 

 

The fields on Search page #3 are as follows: 

 
 From date – click select to bring up the calendar to select the folder from date. 
 To date – click select to bring up the calendar to select the folder to date. 
 Received date – click select to bring up the calendar to select the folder received date. 
 Destroy date – click select to bring up the calendar to select the folder destroy date. 
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Entering new Tapes 

THE NEW TAPE SCREEN 

To enter new tapes, click the Add Button to access the New Tape screen (below).  

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 64 

 

 

 

This screen contains the following fields (the fields marked with asterisks are required): 

 Box Number – Optional: may be entered manually or, by clicking the ellipse, from the pull down 
list.  

 NOTE: A Current Box number is not mandatory, since Tapes can be stored on open shelves 
without boxes.. 

 Company – Client Code, automatically populated when the box number is entered. 
 Department – (10 position alphanumeric) department code, which may be selected from a pull 

down list by clicking the ellipse.  
 Tape Number – (three digits) populated automatically, but may be changed manually. 

 NOTE: Because each box has unique Tape numbers, the Add Tape Screen cannot be saved if a 
duplicate Tape number is manually entered.. 

 ID – (10 position alphanumeric) typically, the last name or initials of the person responsible for this 
Tape, such a manager or corporate officer in the client company. 

 Matter No. – (13 characters, alphanumeric) may contain legal case numbers, medical patient 
numbers, insurance claim numbers, etc. 

 Received Date – (date field) date Tape was received into the record center. 
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 Destroy Date – (date field, automatically populated from box data) month, day, and year this Tape 
is eligible for destruction. 

 From Date – (date field) used in conjunction with To Date to indicate time period of the records in 
Tape. 

 To Date – as described above. 
 Major Description – a general description of Tape.  
 Minor Description – a detailed description of Tape contents. 
 Tape type – In-house codes can be used to designate the type of tape media, i.e. MT for 

magnetic tape, DAT for DAT cartridge, CD if it is a CD, etc. 
 Next rotation date – the next scheduled day for rotation of this tape. 
 Rotation days – how often (in days) this tape should be rotated. 
 Comments – (unlimited text field) use to input additional information about the tape. Word 

documents or spreadsheets can be pasted here. 
 Location Code – the location of box containing this tape; populated automatically from box 

information if the tape is part of a box or the open location of a tape not stored in a box. 
 Cross Reference – press this button to 

access the Tape Cross Reference List 
(right). 

Cross referencing is used when a box 
or Tape is known by more than one 
reference number. This can occur, for 
example, when your record center 
absorbs boxes from another center, or 
needs to renumber the customer’s 
boxes for any reason.   

Fig. 65 

 
An unlimited number of cross refer-
ences – typically, client’s file numbers. 

Only the first cross reference is displayed on the Tape Edit Screen, but all the cross  
references are searchable. 

 Filtering – applies a filter to your list. Tapes can be filtered just like  
boxes or folders, with single or multiple filters.  
  

Remember that the wildcard character is %. As with all Archive Manager lists, query results may be 
sorted by clicking on the column heading.   
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THE CURRENT TAPE SCREEN 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 66 

 

 

 

To edit information about a tape, either double click the item on the Maintain Tapes screen (Fig. ), or 
select it and click Edit.  

The Current Tape screen appears (above).  

The quickest way to find a specific tape on the Maintain Tapes screen is by filtering a list.  

The fields and field descriptions on this screen are identical to those on the New Tape screen, above. 

Checking Tapes In and Out 

THE TAPES CHECK IN/OUT SCREEN 

Click the Check Out button 
on the Current Tape screen to 
access the Tapes Check 
In/Out screen (right). 

This screen is identical in 
functionality to the Boxes 
Check In/Out Screen 
(Chapter 5, Fig.45 ). The 
process for checking Tapes in 
and out is identical as well. 
See Chapter 5 for a review of 
the subject.  

Fig. 67 
For detailed instructions about Tape Reports, see The Tape Group on Page 95 in Chapter 14, 
Reports. 
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2.  If selecting more than one item, 
hold down the <Ctrl> key. 

3. Right click the selection and  
choose Add to List. 

Chapter 8 – Lists 
Lists are an extremely useful way to organize and expedited check outs, destruction processing, 
permanent removals, and other repetitive tasks. See Using Lists, below, for specific uses.  

Managing Lists 

THE MANAGE LISTS SCREEN 

The Manage Lists Screen (right), 
displays a list of existing lists from 
which you can… 
 use filters to find a specific list, 
 select a list to print, edit, or 

delete, or 
 create a new list. 
To access this screen, select the 
Maintain Panel on the Activity Pane 
and choose Lists, or click Maintain > 
Lists on the Menu Bar.  

 

 
 
 Fig. 68 

Creating Lists 

THE NEW LIST SCREEN 

To create a new list, click the Add 
button on the Manage Lists Screen 
(Fig. 1, above). On the New List 
Screen (right), enter a name and 
description for the new list, then click 
Save, or Save & Add. 

ADDING ITEMS TO A LIST 

To add an item to a list in the 
Maintain Box, Folder or Tape screen: 

1. Select a single or multiple items, 
or click Select All.  

 
 
 
  Fig. 69 

4. Click the list to which you want your selection to be added. 

5. To view the expanded list, click Choose a List, on the Maintain Box or Folder screen, select the 
list to which the items were added, and click Filter.  
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Using lists 
As mentioned previously, lists may be used for various tasks that can enhance your customer’s sense 
of security while promoting the efficiency and profitability of your operation. 
 
 Repeated or periodic activities – By saving the result of a filter process, a list can save you the 

effort of repeating that process when the same selection is required again. For example, in daily 
check out of boxes or folders, you may want to create a Pull List AM and Pull List PM for morning 
and afternoon retrievals. 

 Destruction or permanent out processes - You can build a list of items to be destroyed, save it, 
print it, and review it with your customer or record center management before proceeding with the 
actual destruction of records. And because lists are automatically saved, you can easily review the 
items selected for a particular client destruction project at a later time. 

 Searching – Lists may be filtered, sorted, and/or printed, and items place in a list remain there 
until removed. 

 Special projects – Your customer may need to review a printed list of certain boxes and folders. 
Here is an example how you would use a list as in the first bullet, above:  

Your client is a builder who needs to show what make and type of roofing material was used in each of 
several previous projects for pending litigation. At his request, you’ve pulled a group of boxes from the 
Maintain Boxes screen (Chapter 5, Fig. 37). Because he may need to refer to other roofing materials 
from these projects in the future, he has asked you to remember which boxes were pulled, so you will 
record them to a list, LIST1, as follows:  

First, you’ll create a new list: 

1. go to the New List screen (Fig.69 , above); 
2. enter the name LIST1 (and a description) for the new list; 
3. then click Save. 

Then you’ll add the requested boxes to the list:  

1. go to the Maintain Boxes screen; 
2. select a box or multiple boxes to add to the list;  
3.  if selecting more than one box, hold down the <Ctrl> key. 
4. right-click the selection and choose Add to List from the action menu; 
5. add the box(s) to LIST1; 

A year later, when you need to retrieve the same boxes again:  

1. go to the Maintain Boxes screen; 
2. select LIST1 in the Choose a List scrollbox; 
3. click Filter. 

FILTERING 

The filters for Name and Description can assist you in searching for a particular list. Remember that 
the wildcard character is %, and clicking on a column sorts the list on that column. 

DELETING A LIST 

Warning - deleting a list results in all items being removed from that list.  The steps to delete a list are 
as follows:  
1. Highlight the list you want to delete in Maintain Lists (Fig. 68, above) 
2. Click the delete key on the bottom of the screen. 
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If a list has items associated with it you receive a warning message.  
Fig. 70 

 

Creating Lists From Spreadsheets 
Using the import Excel spreadsheets typically located in C:\Program Files\RMS\Archive 
Manager\Settings you can import a list of box numbers, box/folder numbers, and box/tape numbers to 
generate a list of boxes, folders, or tapes. This is very useful for generating destruction lists for boxes. 
Have your client give you a list of box numbers to be destroyed. 
 
Excel Files 
Boxes - Import_BNumber.xls - single column of box numbers 
Folders - Import_FNumber.xls – columns of box numbers and folder numbers 
Tapes - Import_TNumber.xls – columns of box numbers and tape numbers 
 
Note: These files must remain named .xls. 
 
Pull down Maintain from the top menu to Lists and over to the right to Create List from 
spreadsheet.  
 

On the Import tab select Boxes,  Folders, or Tapes. Click the 
ellipse to select a client. You cannot type the client code. 
 
 
 
Fig. 71 
 
 
 

 
On the Column Name tab select F_Boxnumber for boxes. If 
you selected Folders, then you would select 
F_Foldernumber/F_Boxnumber. And if you selected Tape, 
then you would select F_Tapenumber/F_Boxnumber. 
 
 
Fig. 72 
 
 

 
 
Click the Execute button to navigate to where your import file is and import your list. 
 
Filter on Choose a List in boxes, folders, or tapes to view the items. Note if any of these maintain 
windows are open before importing, you must close that window and reopen it to see the list. 
List Names 
Boxes - Import_BNumber 
Folders - Import_FNumber 
Tapes - Import_TNumber
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Chapter 9 – Quick Search 
The Quick Search Panel (Figure 66), mentioned briefly in Chapter 1, contains a very powerful set of 
filters that you can use to instantly retrieve information about boxes, folders, locations, and customers. 

Searching for Boxes 

When you search for boxes, you may enter as criteria: 

 

 

These filters may be used individually or in combination. Remember that the 
wildcard character is %.   

For example, if you wanted to find all the boxes marked General Ledger for 
client Sample, you would enter Sample in the Client field, and General Ledger 
in the Description field.  

The result would the display at right, showing all the records in the system that 
match our criteria. 

 

Fig. 73 

 

 

 

 

            Fig. 74 

 

 

Incidentally, if you click the Print button on any screen, you’ll see a print preview screen like the one in 
Fig. , below; just click the icon to send the image to your default printer. 

 

                  Fig. 75 

 

 
 

 

 

• Box #   * Client 
• Description * Cross Reference 
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Returning to our search for boxes, if your record center uses 6-digit box numbers and you wanted to 
find all the boxes in the range of 510550 to 510559, you would enter 51055% - using a wildcard, 
meaning any digit, to represent the last digit. 

Searching for Folders 
When you use Quick Search to search for folders, you can use the following criteria, individually or in 
combination: 

 

 

Searching for Locations 
You can use Quick Search to search for a specific location, or a group of locations, such as an aisle. 
For example, if you wanted to see all the boxes on aisle 14-A, you would simply enter 14-A in the 
Location field. 

Searching for Customers 
The Customer field is used to 
search for a customer listing by 
name. If you don’t know the 
customer code for a particular 
customer, for example, you would 
enter all or part of their name here.  

You can use the wildcard character 
to replace any letter or number in 
your search. The result would look 
like the illustration at right. 

    

 Fig. 76 

 

 Box # (all folders in box) 
 Matter 

 Major (description) 
 Minor (description) 
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Chapter 10 – Audit Trails 
An Audit Trail is used to display the history and current status of boxes and folders that are or have 
been in the record center. 

Several audit trails are available to track boxes and folders.  
For boxes, these include: 
 check in/outs,  
 location history, and  
 destruction/ permanent out history.  
For folders, the audit trails include  
 check in/outs,  
 box history, and 
 destruction/ permanent out history.  
To access the Audit Trail Screen (right), click the Audit Trail icon in the Shortcuts Task Panel, or you 
can click Setup>Audit Trail on the Menu Bar.  

The tabs at the top of the screen provide access to each of the audit trail functions. 

    Fig. 77 

 

 

Box History 
The Audit Trail Screen opens by 
default to the B History tab. This audit 
trail tracks boxes that have been 
destroyed or permanently removed.  
Three Audit Trail symbols are 
employed:  
 Gray arrows represent boxes that 

have been permanently removed.  
 Red x’s represent boxes that have 

been destroyed.  
 Green check marks represent items recalled. 
 
 
There are filters for 
 Client – the Client Code. 
 Name – name of the authorized person from the client. 
 Status – Pull down to select All, Perm Out, or Destroyed. 
 Box # - the box number. 
 Ticket # - the ticket or order number. 
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Box Location History 
The Box Location History audit trail tracks boxes as they are moved from one location to another 
within the record center. 
There are filters for 
 Client  
 Box #  
 From location code – the original location of the box(es) 

Box In/Out 
Box In/Out tracks boxes as they are checked out from and returned to the record center. 
There are filters for 
 Client 
 Box # 
 Ticket # 
 Out Only (check this box if you want to see only items which are currently checked out) 

Folder In/Out 
Folder In/Out tracks boxes as they are checked out from and returned to the record center. 
There are filters for 
 Client 
 Box # 
 Ticket # 
 Out Only (check this box if you want to see only items which are currently checked out) 

Folder Boxing History 
Folder Boxing History tracks folders as they are moved from one box to another within the record 
center. 
There are filters for 
 Client 
 Box # 

Box # - this is the new box the folder has been moved to. 

Folder History 
To access this feature, click the F History tab. Folder History tracks folders that have been destroyed 
or are permanently out.  
Three Audit Trail symbols are employed:  
 Gray arrows represent boxes that have been permanently removed.  
 Red x’s represent boxes that have been destroyed.  
 Green check marks represent items recalled.  
 
There are filters for 
 Client – the Client Code. 
 Name – name of the authorized person from the client. 
 Status – Pull down to select All, Perm Out, or Destroyed. 
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User Audit Trail 
 
 
To access the User 
Audit Trail list click 
Setup > User Trail. 
Archive Manager 
tracks newly added 
and edited boxes and 
folders by user. It 
records the date of 
the addition or change 
by User Name.           
Fig. 78 
 
 
 
 
 

  
 
 
Filters - Several filters are available and may be used in combination. 
 Username – User’s last name 
 Box number – box number 
 Folder number – folder number 
 Operation date – click Select to bring up the calendar to select desired date(s) 
 Search folders only – click to limit your results to solely folders 
 
There is also a User Audit Report in the Base group of reports. There are filters for: 
 Box number 
 Folder number 
 Operation date 
 User 
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Chapter 11 – Billing 

The Charges Screen 
The Charges screen (below) displays the history and status of your entire client billing. Like all Archive 
Manager screens, it may be sorted on any column by clicking the column heading.  

To access this screen, click the Billing icon in the Shortcuts Task Panel, or click Billing on the Menu 
Bar. 

 
    Fig. 79 

CHARGES SCREEN LEGEND  

 Green dot – Current charge, not yet processed 
 Blue dot – Daily charge, not yet processed 
 Red dot – Processed charge  

Entering charges 
New charges are always entered from the New Charge Screen (Figure 56, next page), which you can 
access in several different ways: Entering charges 

 from the Charge Screen, by clicking the Add button; 
 from the Current Client screen by clicking on the Fixed or Current Charge button, or  
 as you perform operations such as check/in out, destruction process, permanent out, etc. by 

checking the Insert Charges box.  
The New Charge Screen permits you to itemize every billing item, so that you can show the complete 
break down of all fees, services, and other billables via a single Charge Ticket. 
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Charge Types 
There are two types of Charges: 

 Current Month Charges – These 
include services rendered during 
the current month, such as 
Deliveries, Pick Ups, ReFiles, etc. 
Such items must be entered 
individually to appear in monthly 
billing.  

Current Charges, Fixed 

 

 

 

 

 Fig. 80 

Entering Data 
The New Charge Screen contains the following fields (fields with asterisks are mandatory): 
 Charge Type – Pull down the menu to select either Current or Fixed. 

 Client (mandatory) – Enter the Client Code manually, or click the ellipse to select the code from 
the Maintain Clients Screen. Archive Manager validates the entered code against the Maintain 
Clients table and inserts the corresponding name in the field to the right. If the computer is unable 
to find the client, an “Invalid Client Code” message is displayed. 

 Department – This field is used for clients who prefer to be billed by department. Enter the 
Department Code manually, or click the ellipse to select the code from the Client Departments 
screen. Archive Manager validates the entered code against the Client Departments table and 
inserts the corresponding department name in the field to the right. If the computer is unable to 
find the department, an “Invalid Department Code” message is displayed. 

 Billing Code (mandatory) – You can either enter the code manually, or you can click the ellipse to 
bring up the Billing Codes List screen. You can use the filters, if necessary, to select the desired 
billing code. Archive Manager validates the entered code against the Billing Codes List table and 
inserts the corresponding Billing Code description in the field to the right. If you enter a Billing 
Code that is not in the list, you will be prompted “Insert a Manual Charge?”. This permits you to 
enter a One Time charge that will appear on the Invoice without having set up any Billing Code. 
When you insert a Manual Charge, you must also enter a description. 

 Fixed Charges – These 
represent ongoing or recurring 
billing items that change 
infrequently, such as rental for 
a shelf or room, for storing an 
entire file cabinet, etc. 
Because these charges are 
recurring, you can enter the  
information only once, and  
Archive Manager will then  
include them in each billing  
cycle. Fixed charges are 
entered in the client edit 
screen (chapter3). 
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 Ticket Number – This item is sometimes referred to as a Work Order. It is a tracking number 
provided by you, and used by Archive Manager to track this particular service transaction. The 
number could typically be copied from your order entry form, or from the customer’s service 
request when the customer is using a pre-numbered order form to request services. 

 Ticket Date – This is the date on which a service is actually performed. If you are entering 
charges daily, it would likely be today’s date. If you are entering charge tickets weekly or monthly, 
then you would want to enter the charge ticket dates. 

 Billing rate (mandatory) – The correct billing rate is automatically inserted in this field when a 
billing code is entered. For manual charges, you must enter the rate yourself. 

 Tax rate – For customers subject to sales tax, the tax rate appears automatically. This is copied 
from data recorded by Archive Manager from the Customer Contract Screen (Fig. 23). The tax 
rate used may be changed for a particular charge. 

 Taxable – For items that are set up as taxable in the Maintain Billing Codes Screen (Fig. 14), this 
box is checked automatically. It may selected or unselected here for this particular charge 

 Quantity – Enter here the number of items associated with this charge. 

 Amount – Sub-total of the charge, calculated automatically. 

 Sales Tax – Applied to taxable items only, calculated automatically 

 Total – Total amount of this charge, calculated automatically 

FILTERING 
The Charges Screen may be filtered using any of the following filters, individually or in combination: 
 Client – The Client Code. Click the Exact match box to match the client code exactly. 
 Description – The description of the charge 
 Status –  

 UnProcessed – all unprocessed charges 
 UnClosed – all charges that have not been closed to a month. 
 All – all charges in the file 

 Billing Code  - The billing code 

 Ticket # - The ticket or order number 

 Date filters – (second tab) The ticket dates 

 Type –  
 All – Both daily and current charges. 
 Daily - Only daily charges. 
 Current – Only current charges. 
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Chapter 12 – The Maintain Orders Module 

The Orders Screen 
The Orders screen displays a 
queue of item orders that your 
record center has received either 
from the Web Access system, or 
from orders that you have created. 
Orders from Web Access are 
indicated by a Ticket Number 
format of  
“WEB-###”. 

NOTE: “Order Number” and 
“Ticket Number” are identical and 
are used interchangeably. 

 Fig. 81 

To enter the Orders screen, you 
can either click Maintain > 
Order>Orders on the Menu Bar 
(right);  

 

 

 

– or you can use the Orders button from the Maintain panel (left). 

 

  

 

 

 

 

 

 

 

Fig. 82 
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The Orders screen appears, displaying the following columns, from left to right: 

 Order date 
 Ticket number 
 Client code 
 Department number (if applicable) 
 Requester 
 Address 
 Processed 
 Web order 

 
 Fig. 83 

The screen includes a window that displays the Web Access system message, advising you that an 
order has been received. It also includes the familiar Filter facility. The list can be filtered by: 

 Client code 
 Department 
 Ticket number 
 Processed – check this box to select processed orders 
 Invalid - check this box to select invalid orders 
 Web Order - check this box to select Web orders 
 Order date – brings up calendar to select order dates 

Orders may be sorted in the same manner as the other Maintain screen lists. 
Returning to the Order command on the Menu Bar, select the Standard Items option to view the 
Standard Actions screen. Unlike most commands, Standard Items is available only on the Menu Bar, 
since it is typically used only once for a setup operation. 
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Standard Actions 
 

To enter the Orders Standard Actions screen click Maintain > 
Order>Standard Actions on the Menu Bar. 

The Standard Actions screen (right) displays the list of billable 
actions available in Archive Manager; i.e., check in, check out, 
destroy, etc.  

A billing code can be associated with each action so that clients 
are automatically billed a predetermined fee for any action 
performed (autobilling).  

To set up this function, simply edit the desired action, applying an 
appropriate billing code from your Master Billing Code list.  

To edit an action item In the Standard Actions screen, double-
click the item; an edit screen opens where you can enter the 
required billing code (below). 

 
           Fig. 84 

 
 

Fig. 85 
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Creating a Blank Work Order 
When a new work order is 
created, it starts out blank or 
empty, and information is then 
added to it. 

To create a blank work order, 
click the Add button at the bottom 
of the Orders screen (Fig. , 
above). 

The New Order screen appears, 
where you will be asked to 
identify the client and the 
department, and to enter the 
requestor of the order, phone 
number, etc. (similar to the screen 
that pops-up at checking out 
items).  

 

 

 Fig. 86 

 
 

To populate the Client 
field at the New Order 
screen, click the ellipsis 
(three dots) to the right 
of the Client field to 
open the  Maintain 
Clients screen (right).  

Highlight the desired 
client, and then click 
the Select button at the 
lower right of the 
screen.  

Or if you know the 
client code, just type it 
in. 

 

 Fig. 87 
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You are returned to the New Order 
screen, where the selected client now 
populates the Client field. Follow the 
same procedure to populate the 
Department field, then enter the 
remaining data. 

When you are finished entering 
information, you may then add 
instructions or comments of any length 
for the delivery ticket; for example, 
special instructions to the driver. 

When you have completed the New 
Order screen, click the Save button.   
 
 Fig. 88 

 

 

Finally, click the Save button on the New Order screen. You are returned to the Maintain Orders 
screen, where the new blank order appears. The new order now includes a Ticket Number, which is 
supplied automatically by Archive Manager. If you reopen the Add Orders screen for this order, the 
new Ticket Number will appear in the Ticket Number box.  

NOTE: Write down the Ticket Number for the new order - you’ll need it shortly. 

Adding Items to the Work Order 
Note that we have not added any items to our blank order yet. We are about to do that now. 

We will now add a “checkout 
box” item to the order we just 
created, as follows: 

1.  Go to the Maintain Boxes 
screen. 

2.  If the Client Number is   for 
example 600, filtering on 
600 will display all the 
boxes for Client No. 600. 

3.  Click to select the row with 
the desired box, and then 
right-click to view the action 
menu. 

 

 Fig. 89 
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4.  From the action menu, select Add to Order, and then Check Out.  
 The Select Order screen appears (below). 
Note – you can create a brand new order 
within the boxes, folders, or tapes lists by 
clicking New Order. 
 

 

        Fig. 90 

 

 

5.  Click the ellipsis to the right of the Order number box to display a list of existing orders in Archive 
Manager.  

6.  Filter on Client Number 
600 (from our example, 
above) to see existing 
orders for just this 
client. 

7.  Highlight the order 
corresponding to the 
ticket number you 
recorded after you 
clicked the Save  
button, above.  

8. Finally, click the Select 
button. 

The box has now been 
added to the previously 
blank order.
  Fig. 91 

Adding Non-Item Billing Codes to an Order 
“Non-item” billing codes are used for supplies 
(such as labels), or services (such as a 
general pickup) that are not typical service 
items.  

To add non-item transactions from the 
Maintain Orders screen: 

1. Filter on the client number again, highlight 
the desired order, and either double-click 
the row, or click the Edit button. The Order 
screen appears again.  

 
 Fig. 92 
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2. This time, click the tab for Non 
item billing codes. 

3. Click the ellipsis to select a Client 
billing code from the Maintain 
Billing Codes screen. 

 Highlight the desired row and 
click the Select button to return to 
the Order screen. 

 

 

 

 

 Fig. 93 

 

 

 

 
 
4. Enter the quantity and click the Add 

to order button. The new order 
appears in a row on the screen. 

 

 

 
 
 Fig. 94 

 
 
 
 
 
 
 
5. Now click the Items tab to see the new 

items in your order. 
 

 

 

 Fig. 95
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6.  Next, click the Order tab to return to the Add Order screen, and click the Process button to finalize 
the order. A prompt notifies you that from this point, you cannot modify the order. Click OK to 
proceed. 

   NOTE: The order cannot be modified after this point.  

After you click the Process button, you will see another confirmation prompt: The order has been 
processed.  
7. A subsequent prompt asks: Do you want to 

auto-bill the order items?  
 If you click Yes, a charge is automatically 

generated in the Maintain Billing table. 
 Fig. 96 

 
 
 
8. Finally, go to the 

Report Module and 
print the delivery 
ticket (see Delivery 
Ticket Reports in 
Chapter 14). 

To locate and print the 
single order you just 
created, just filter on the 
order number. A more 
practical procedure would 
be to select Mark as 
Printed to print all new 
orders that have not 
previously been printed. 

 
 Fig. 97 
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Chapter 13 – Month End & Using QuickBooks 

Setting Up QuickBooks 
First, set up QuickBooks according to the instructions provided in its 
manual. After you have completed the installation, follow the steps 
outlined below to create a link between Archive Manager and 
QuickBooks. All the steps employ QuickBooks menus. 

Before we begin, if you are using a multi-user version of QuickBooks 
you need to switch to single user mode to access the menus we 
need. Click File > Switch to Single User Mode; the prompt advises 
you that you have changed modes.  

 Fig. 98
 

 

 

ESTABLISH AN INCOME ACCOUNT 

To open the Chart of Accounts, 
either click the Accnt icon in the Icon 

Bar, or click Lists > Chart 
of Accounts on the Menu 
Bar. Then, right-click 

anywhere in the ledger and select 
New from the action list to access 
the New Account screen (right).  

1. In the Type scrollbox, select 
Income.  

 
 
 
 Fig. 99 

 
3. When you have completed this form, click OK. 

TELL QUICKBOOKS THAT YOU CHARGE TAXES 

In QuickBooks, click Edit > Preferences on the Menu Bar to display the Preferences window. 

1. Click the Sales Tax icon from the topic list in the left panel. 
2. Click the Company Preferences tab. 
3. Under Do You Charge Sales Tax?, select Yes. 

 

2. In the Name field, enter the 
same name you entered in  
the Company Setup screen 
  
(Chapter 2, Fig. 8). The  
name used in the illustration is  
RMS ARCHIVES  
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CREATE A TAX AGENCY 

Next, click Vendor>Vendor List, and in the New Vendor screen, enter the agency that collects your 
sales tax in the QuickBooks Vendor List as though it were a vendor; i.e., New York State - Sales Tax.  

The name must be identical 
to the name entered in Archive 
Manager’s Company Setup 
screen (Chapter 2, Fig. 8).  

Also enter your current 
outstanding Sales Tax balance 
for this quarter. 

Your screen should look like 
Figure 76 at right.  

On the Additional Info tab, 
enter your TIN (Tax ID 
Number) for this authority, and 
in the Type scrollbox, select 
Tax agency. 

When you are finished, click  
OK to save your entry. 

 Fig. 100  

If you are using a multi-user version of QuickBooks, you were instructed to switch to single user mode 
before we set up the Income and Vendor accounts. Now you should return QuickBooks to multi user 
mode following the procedure outlined above. 

LOCATE YOUR QUICKBOOKS FILE 

Archive Manager needs to know where to find the data file in which QuickBooks stores your 
accounting information. This requirement was mentioned in Chapter 2 when we discussed the various 
fields in the Company Setup screen (Chapter 2, Fig. 8). Go to that screen now and check to see if you 
completed this field correctly, and that it contains the file’s full (absolute, rather than relative) 
pathname.  

If the field is not correctly filled, click the ellipse to the right of the field to navigate to file’s location. Its 
extension is *.QBW, and it is usually found in: 
 
    C:\ProgramFiles\Intuit\QuickBooks\[QuickBooks account name].QBW.  

Daily invoicing 
Daily charges appear in the Charges screen with a blue dot. Daily charges may be used for special 
one time projects or large pick ups and deliveries.  

To export a daily invoice to QuickBooks, go to Export > Accounts. 
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Month End Process 
The month end process is one of Archive Manager’s most important accounting functions. In this 
procedure, Archive Manager exports all unprocessed current charges to QuickBooks, which creates 
invoices for each of your customers.   

It is prudent to take certain precautions before actually doing a month end close, to ensure data 
integrity and accuracy. These include:  

 Run an Interim Charge Ticket report (see Chapter 14 – Reports) for all clients prior to proceeding 
to ensure that all charges have been entered properly. 

 Check to see that all clients have been exported to QuickBooks, or have been entered manually, 
exactly as they appear in Archive Manager, including the Bill To address. 

 Check to see that all new boxes have been scanned into proper locations. It is advisable to run an 
Interim Storage report. 

 Check to see that the income account has been correctly set up in QuickBooks. 
 Check Archive Manager’s Company Setup screen (Page 6, Fig. 8) to see that Archive Manager 

has correct information including the tax agency, tax on storage option, and whether to include 
service and storage charges on one invoice.  

 Do a back up of your data. 
When you have completed these steps and are ready to proceed with the month end process, 
proceed as follows: 

PROCEDURE FOR MONTH END 

1. On the Main Menu bar, click Billing and 
scroll down to End Month.  

 The popup at right appears: 
Fig. 101 

 
 
 
2.  Respond Yes to 

continue.  
 The End Month screen 

appears (right).  

3.  In the Month field, 
select the month you 
are closing.  

Fig. 102 

  

 

 

 In the illustration above, the month ending is January. In the Date field, by default, the first day 
of the following month will appear.  
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4. Click the carat in the Date field, and use the calendar tool (right) to select either the last day of 
the month you are closing, or the first day of the 
next month. 

Fig. 103 

5. From the End Month screen, (Fig. 98, above) 
select the checkboxes to choose whether to 
include quarterly or annual storage charges.  

6. Click Process Charges.  
a. If charges were entered in Archive Manager 

during the month that have not yet been 
exported, a  
prompt appears  
(right) to tell you “There are some 
unexported charges.” 

  Fig. 104 

 
This is to remind you 
that these charges 
will  
be safely exported 
along with your other 
billing. 

b. If Process Charges was already executed this 
month, an error message appears, saying “Error: 
This month is closed.” (right). 

Fig. 105 

 

Finally, when the process has been completed successfully, you 
will receive a prompt saying “The Month End process was successful.”  

Your invoices have been generated. You can now choose whether to print them in QuickBooks or in 
Archive Manager. 
 

Printing Invoices in Archive Manager 
To print your invoices in Archive Manager: 

1. Click Reports on the Main Menu bar.  

2. In Report Category, select Charges (Invoices). 

3. In Report Names, select End Month Invoice. 
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The End Month report screen appears as below. 

 

 Fig. 106 

4. In the Parameters fields, enter (numerically) the month and year you are closing. In our 
example, above you would enter 10 for October and 2017 for the year.  

5. Enter the 4 digit year in the format shown above.  

6. Respond YES to End Month, and leave Mark as Invoiced as NO. 

7.  Select ALL to print all invoices, PDF for those clients to have PDF invoices generated and 
emailed, or Print for just those clients who receive a printed invoice. 

Click the Execute Report button                                  .   

The Invoice is displayed in Preview Mode, as illustrated below. If you have selected PDF 
invoices, you will first get a pop up of the number of successfully emailed invoices and screen 
print will only be those invoices. 

 

 
Fig. 107 
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DEPARTMENTAL INVOICES 

To print Departmental Invoices, follow the procedure outlined above, but select Departmental Invoices 
at the Report Name field above. If you have entered a different address for the department, that 
address will be printed. 

 NOTE: If you make a mistake, you can roll back the month by using the Rollback End Month 
option in the Accounts Export feature, described below.  

Exporting Invoices to QuickBooks 
      (and Other Accounting Packages) 
To export invoices for use in QuickBooks and other accounting packages: 

1. On the Main Menu bar, click Export > Accounts export. 
The Accounting System Export screen appears, below. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Fig. 99 

 
 
 

Fig. 108        

2.  Under Data to be exported, select the invoice items you wish to export. The choices are: 
 Customer records 
 End of month billing 
 Middle of month billing 
 Product records (billing codes) 

3. Under Options, select one or both choices: 
 Mark as exported, and/or 
 Export All (including previously exported for current month) 

 NOTE: Select “Mark as exported” only when you are ready to close the month. 
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4. Finally, click Execute to export to accounting 
This will place three files on your PC in C:\Program Files\RMS\Archive Manager\Bin: 

 Customer Records.iif 
 Product Records.iif 
 Current Product Tranaction Records.iif 

ROLLBACK END MONTH 

As mentioned above, if you make a mistake and need to undo your End Month process, you can 
return to your pre-End Month status by using the Rollback screen, as follows:  

1. Click the gray area at the bottom of the screen labeled Rollback end month/current charges.  
 

 
Fig. 109 

 
 

 The Rollback screen appears, offering you the following two options:  
 Rollback Current Charges, or  
 End of Month charges. 

 
 
 
 
 
 
 
 
 

Fig. 110 

 
 
 
 
2. Make your selection. 
3.  Click the Execute button.  
 If the files have not been exported already, the monthly charges are reinstated as 

unprocessed.  
 You may now add or edit charges and close the month again.  

 NOTE: Once the export process has already taken place, you cannot roll back. 
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Importing Invoices into QuickBooks 
To import invoices into QuickBooks:  

1. Start QuickBooks 
2. Change QuickBooks to Single User mode. 
3.  At the Main Menu bar, click choose File > Utilities > Import > Import IIF files. 
4. Import the files in the following order: 

a, Customer Records.iif 
b. Product Records.iif 
c. Current Product Tranaction Records.iif 

You are now ready to go to QuickBooks to print your invoices. 

Printing Invoices in QuickBooks 
To print invoices in QuickBooks: 

1. Start QuickBooks. 
2. Select Customer > Customer Navigator from the QuickBooks Main Menu bar.  
3. Under Related Activities, click Print Invoices. 

Your invoices are automatically created and will now appear in QuickBooks. 

They may be reprinted at any time.  

You now have at your disposal QuickBooks’ first class receivable tracking system, its convenient 
accounting features, and a wide variety of QuickBooks reports 

.
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Chapter 14 – Reports 
To open the Reports module, click Reports from Shortcuts on the left task pane. Or, from the task bar 
menu, click Reports > Reports.  

General conventions 

SELECTING REPORTS  

From the pull down menu, select the group of report from which you will select; either  

 Base group – information about box and folder storage 
 Charges (invoices) – discussed in Chapter 13: Month End 
 Client information – client activity statistical reports  
 General – Information about code table contents. 
 Tapes – information about tape storage 
 

FILTERS 

Filters allow you to set parameters for which customer, departments, locations, etc. will be included in 
a report. With the Filter pane, on the right, you can use Boolean logic to build hierarchical queries to 
obtain the information you want. Simply follow the prompts to build the query or filter you want. Note 
like looking up information on the maintain lists, the wildcard character is % for the filter operator 
Contains. 

 Adding filters – After entering each filter selection, click the Add filter button. The filters you enter 
are displayed in the filter dialogue box at the bottom of the screen. The report will be sorted in the 
order in which the filters appear. 

 Deleting filters – To delete a filter, first click on its line in the filter dialogue box, then use the 
Delete filter button to remove it. You may also delete filters using the Load Saved Filter window, 
discussed below. 

 Save filter setting – After you have set filters for a report, you can press the Save Filter button to 
save those settings to a file. When a report is successfully saved, a prompt appears saying, “Filter 
has been saved.”  

 This is a very useful tool for reports such as box and folder inventory reports. With saved filters, 
you need to generate the filters only once, and you can then save the report settings for future 
uses. 

 Load saved filter – Pressing the Load Saved Filter button brings up your list of filters. To choose 
one of the displayed filters, highlight the filter and click the Select Filter button. To delete one, 
click the Delete button, instead. 

 Setting order – In most reports, you can choose how you want the data ordered by clicking on the 
column heading.  

 Choosing visible columns –In most reports, you can choose what columns to include or omit by 
clicking on the Visible Columns headings.  

 Execute report – Once the filters, sort order, and columns have been selected, press the Execute 
button report to run the report. All reports automatically preview to the screen and from there you 
can utilize the navigation icons to proceed. 
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Base Group 

AUDIT REPORT  

The Audit Report (below) is an extremely effective report that allows you to audit the Archive Manager 
system by   Base Group 

 Location range 
 Space number 
 Customer 
 Department, or 
 Description 
The illustration at right 
shows how the Audit 
Report setup screen 
would be configured to 
audit the system by 
Location Range. Using 
this filter, the report will 
show you what Archive 
Manager thinks is in 
each location, with 
provisions to verify the 
presence or absence or 
each box.  
 

 Fig.111  

 

When the Audit Report 
setup screen is completed 
and the filters are saved (if 
desired), click the Execute 
Report button to display 
the Report screen, 
illustrated at right (Figure 
81). 

Since the report is by 
location, the group tree in 
the left pane will navigate 
from one location to the 
next.  

If a different filter is 
selected – the Customer 
filter, for example – the 
tree icons would navigate 
customers instead of 
locations.  

 

 

 Fig. 112 
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Navigation buttons for navigating displayed reports 

 
 Chevrons – Click the chevrons to open and close the filter and navigation panels.  
 Export report – Click this icon to export the finished report to your choice of various file formats; 

PDF (the default and our recommended solution), Microsoft Excel, Microsoft Word, or Rich Text 
Format. A standard Windows navigation tree is used to create a path and name under which to 
save your file.  

 Print – Click the Print icon to print your report using the specified printer. 
 Toggle group tree – Click this icon to bring up a navigation tree to jump to clients, departments, 

locations, etc., depending on the report you are viewing. 
 Go to page – Click to specify a page to jump to in the preview window. 
 Zoom – Click this to display a pull down menu of available zoom sizes.  
 Find text – Use this tool to find any character string in a report. 
 Full screen mode – Use the Chevrons and Zoom to display your report in Full Screen Mode. 

BOX INVENTORY REPORT 

The Box Inventory Report 
(right) has a large number 
of selection criteria. The 
best way to cope with 
them is to save special 
report formats for 
individual clients. 
Parameters 
Page break on every 
department YES, NO, 
NONE   Fig 113 

Filters 
 Customer 
 Department 
 List 
 Received Date 
 Box Contents 
 Box Number 
 Record Title Code 

Order By 
 Box #  
 Client name 
 Description 
 Cross reference 
 From date 
 Received date 
 Record Title Code 
 To date 
 Ranges 

 

Visible Columns 
 Location code 
 Box size code 
 From date 
 To Date 
 Destroy date   
 Check out information 
 Received date 
 Ranges 
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Filters 
 Box number 
 Customer 
 Department  

 

BOX CONTENTS REPORT 

The Box Contents Report  
is very similar to the Box 
Inventory Report and the 
filters are nearly identical, 
but it includes additional 
information about the 
folders within the box.  

                       Fig. 114 

As with the Box Inventory 
Report, the best way to 
work with selection criteria 
in this report is to save  
special report formats for individual clients. 

 

BOXES WITHOUT FOLDERS 

This report lists all the 
boxes for the specified 
client for which there are 
no folders. 

Parameters 

 Page Break on Dept 
Yes or No 

 

 

  Fig. 115  

Received date 

BOXES WITHOUT TAPES 

This report lists all the boxes for the specified client for which there are no tapes. It is very similar to 
the boxes without folders report. It has the parameter for page break by department and the same 
filters as above. 

DESTRUCTION PROCESS 

After boxes are destroyed, 
the Certificate of 
Destruction (Figure 85) is 
the list of the boxes that 
have been permanently 
removed or destroyed. 

Filters 
 Customer 
 Box number 
 Destroy Date 
 Ticket #   

 Fig. 116  
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DESTRUCTION SUMMARY REPORT 

The Destruction Summary 
Report (right) lists the 
number of boxes by code 
that have been destroyed 
or permanently removed 

Filters 
 Customer 
 Destroy Date 
 Box size code  
 Ticket # 
 Fig. 117  

As the illustration shows, when a date is used as a filter, a calendar applet appears from which you 
can choose the date. 

 

DESTRUCTION PULL LIST REPORT 

Using the Destruction Pull 
List Report, set the filter to 
destroyed boxes. Then 
use the pull list filters to 
generate a report of boxes 
to pull for destruction or 
permanent removal. 
 
 
 
 
  

 Fig. 118 

 
DESTRUCTION OPEN SPACES 

REPORT 

The Destruction Open 
Spaces Report (lists the 
spaces in the center that 
have been opened as a 
result of a destruction or a 
permanent removal. 

Filters 
 Actual Destroy Date               Fig. 119      
 Customer   
 Date 
 Location 
 Ticket # 
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Remember that, as each 
box or folder is checked  
out, Archive Manager  
automatically calculates  
30 days from the current  

 
 
 
 

DELINQUENT RECORD REPORT 

The Delinquent Record 
Report lets you impress 
your clients by reporting 
checked out items that 
have not been returned to 
Record Center by their 
Return By date.  

 

 

 Fig. 120 

date and uses that as the Return By date. This process reviews this date and determines which items 
are now considered as late. 

Filters 
 Customer 
 Department 

Order by 
 Box Number 
 Description 

 
DELIVERY TICKET REPORT  

The delivery ticket is the document used to facilitate services to your client. It contains instructions to 
your driver with regards to pickup and delivery of boxes, folders, and magnetic tapes, and supplies 
such as preprinted labels. It also serves as confirmation for services rendered. Everything on a 
delivery ticket is driven by a work order. 

This Delivery Ticket 
Report provides for 
printing of your pickup and 
delivery tickets. 
Parameters 
 Mark as Printed (Y/N) 
 Reprint (Y/N) 
 Ticket Type 
 Use alternate address 
 Use dept address  Fig. 121 

Filters 
 Customer   
 Department  
 Ticket #   
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DESTRUCTION NOTIFICATION REPORT 

The Destruction Notification Report (Figure 91, below) informs your clients when particular boxes are 
eligible for destruction. It is based upon the Destroy Date provided by them. If clients do not provide 
destroy dates, Archive Manager inserts the default value 12/31/9998 (never destroy) in the Destroy 
Date field.  

 NOTE: This report does not destroy any boxes. It simply prints a report showing which ones are 
eligible for destruction based on the Destroy Date. Boxes are actually destroyed via the 
Destruction process. 

There are three signature 
spaces at the end of the 
report. It is advisable to 
have your clients sign their 
approval before 
proceeding with any 
destruction. 
 
 
 
 
 
 Fig. 122 

 
Parameters 
 Include folders (Y/N) 

Filters 
 Destroy date 
 Customer 
 Department 
 Include folders 
 Visible Columns   
 Box number 
 Location code 
 Box size 
 Receive date 

Filters (cont’d) 
 Destroy date 
 From date 
 To date 
 Description  
 Record Title 
 Cross reference 

Order By 
 Box Number 
 Client name 
 Description 
 Cross reference 
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FOLDER INVENTORY REPORT 

The Folder Inventory 
Report, like the Box 
Inventory and Box 
Contents Reports, has a 
large number of criteria. 
As with those reports, the 
best way to work with 
selection criteria in this 
one is to save special 
report formats for 
individual clients. 
 
 
 
 Fig. 123 

 
Parameters 
 Page Breaks? (Y/N) 
 Include Comments? 

(Y/N) 

Filters 
 Customer 
 Box Number 
 Department 
 Received Date 
 ID 
 List 

Visible Columns 
 Received date 
 Destroy date 
 From date 
 To date 
 Major description 
 Minor description 
 Matter No. 
 Folder checkout 
 Cross references 

 

Order By 
 Box #  
 Client name 
 Cross reference 
 Folder # 
 Major  
 Matter 
 Matter # 
 

 

FOLDERS CHECKED OUT REPORT 

The Folders Checked Out 
Report simply lists the 
folders that are currently 
checked out of the record 
center. 

Filters 
 Customer 
 Date Out 
 Department 

 
 
 
 Fig. 124 

Order by 
 Major 
 Minor 
 Matter # 
 ID 
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IMPORT CLIENT DATA ENTRY REPORT 

The Import Client Data 
Entry Report displays the 
result of your import of 
client data. 

Filters 
 Customer 
 Username 
 Box number 
 Import date 
 

 
 Fig. 125 

 

 

INTERIM CHARGE TICKET REPORT 

The Interim Charge Ticket 
Report can be run as often 
as may be required during 
the month. It is commonly 
used by record centers 
midway through the month 
to see how much service 
revenue they have 
accumulated. 
 Fig 126 

Parameters 
 Show processed? 

(Y/N) 

  
Filters    
 Customer 
 Customer # 
 Department 
 Description 
 Work Order Date  
 
Order by   
 Client # 
 Ticket # 
 Ticket date 
 

Order by 
 Box #  
 Date & Time 
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LOCATION MASTERS REPORT 

The Location Masters 
Report allows you to print 
three reports detailing your 
Location Masters. These 
permit you to analyze 
locations throughout the 
center to check for proper 
space utilization. 

 Fig 127 

Parameters 
 Spaces with Open 

shelves - ALL, BOTH, 
YES, NO 

Filters    
 Box Size Code 
 Location Range 

Order by 
 Location code (default order) 
 Box size code 
 

PULL LIST REPORT 

The Pull List Report is used 
for printing out your Pull List.  

After boxes or folders are 
“pulled” for delivery, the Pull 
List can be updated to show 
that they have been removed, 
and that “Box Out” cards (Fig. 
129, next page) have been 
generated. There is a bold 
heading below the location 
‘Legal Hold’ for boxes being 
pulled.                  Fig. 128 

 

Parameters 
 Marked as 

printed 
 Reprint 

Filters 
 Cross reference 
 Customer 
 Location 
 Box Number 

 

 (Filters, cont.) 
 Going to 
 Ticket # 

Order by 
 Box Number 
 Location 
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BOX AND FOLDER OUT CARDS  

Box and Folder Out Cards are put in place of checked out boxes and folders to indicate their exact 
prior location. (Folder Out card shown) 

Parameters 
 Mark as Printed (Y/N) 
 Reprint (Y/N) 
 

Filters   
 Client  
 Location 
 Ticket # 

 

  

 

 

 

 

 

 
 Fig. 129 

 

 

UPLOADING PORTABLE REPORT 

This report prints the 
data from your portable 
bar code reader upload. 
Parameter 
 Summary (Y/N) 

Filters 
 Customer 
 Department 
 Portable date 
 Portable hour 

(military time) 

Order by   Fig. 130 
 Date Time 
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After uploading data, it is useful to run the  
following reports: 
1. a Summary Report, then  
2. a Detail Report.  
The Summary Report provides a count of the items uploaded, per the field you selected as your filter. 

 
 Fig. 131  

 

The Detail Report gives all the details for the uploaded items, sorted on the field you selected for your 
filter. 

 
 Fig. 132 
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 boxes/folders destroyed or 
permanently removed.  

Client Information Group 

CLIENT ACTIVITY REPORT 

The Client Activity Report displays all activity for the date or date range specified. It can include:  

 boxes received into the records 
center,  

 boxes/folders checked out,  
 boxes/folders returned, and/or  
 

 

 Fig. 133 

It is generally helpful to run these reports once per month for your clients. 

Filters: 
 Activity Date 
 Customer 
 Department 
 Received Date 
 Date Range 

 Boxes Received into Record Center 
 Boxes/ Folders checked out 
 Boxes/ Folders returned 
 Boxes/Folders destroyed or permanently removed  

Client Information Group 

CLIENT INFORMATION REPORT 

The Client Information 
Report (Figure 83, right) 
displays the complete 
information about your 
clients as recorded in the 
Client Master File. 

Filters 
 Customer 

Order by 
 Client name 

 Fig 134 
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The resulting report is displayed below. 

 
 
 

 
 
 
 
 
 Fig. 135 
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CLIENT NO. OF BOXES REPORT 

The Client No. of Boxes 
Report displays the total 
number of boxes stored 
for a single client, or for 
all clients. It does not 
break out information by 
box size or storage 
revenue; that is the 
function of the Interim 
Client Storage Report.  

 Fig. 136 

Filters 
 Customer 
 
 
 

 

 

 Fig. 137 
(result) 

 

CLIENT NO. OF FOLDERS  

This report is identical to the one above (except that it is for folders). 

 

CLIENT SHORT INFORMATION REPORT  

This report provides a 
listing of clients’…  

 names,  
 client codes,  
 main contacts, and  
 telephone numbers. 
  

 Fig. 138 (setup) 

 

Filters 
 Customer   

Order by 
 Client name 
  

 Fig. 139(result) 
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CUSTOMER LIST REPORT 

This report displays 
customer by city and 
state and can be filtered 
by Industry. 

Visible Columns 
 Code 
 Name 
 City 
 
 Fig. 140 

 

  

 

 
INTERIM CLIENT STORAGE REPORT 

This report selects and 
summarizes currently 
stored boxes by 
Department and Box Size 
Code. This same report is 
automatically prepared as 
part of the Month End 
Process and provides 
another view of how each 
customer is billed for 
storage charges.  

 Fig. 141 

 

Filters 
 Client 
 Department 

 

Order by 
 Box size code 
 Client 
 Department 
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General Group 

CODE TABLE BILLING CODES REPORT 

The Code Table Billing 
Codes Report displays the 
billing code charges for 
each of your clients. 

General Group 
 
 Fig 142 

 

 

Filters 
 Customer 
 Billing Code 

 

Visible Columns 
 Billing rate 
 Taxable 
 Tax rate 
 Pro rate 
 Auto bill 

Order By 
 Billing codes 
 Customer 

 

 
CODE TABLE BOX SIZES REPORT 

The Code Table Box Sizes 
Report lists the box size 
code charges for each of 
your clients. 

 Fig. 143 (setup) 

Filters 
 Customer 
 Box Size Code 

Order by 
 Box size codes  
 Customer 
 
 
 
 
 
 
 
 Fig. 144 (result) 
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CODE TABLE DEPARTMENTS REPORT 

The Code Table 
Departments Report lists 
the Department Codes for 
clients. 

Filter 
 Customer 

Order by 
Department codes 

 Customer 
 

 Fig. 145 

 
CODE TABLE INDUSTRIES CODE REPORT 

This report lists the 
Industry Codes that have 
been set up in Archive 
Manager. 

Filters 
 Industries Codes 
 Industries Names 

 
 

 

 
 Fig. 146  

CODE TABLE MEDIA CODES REPORT 

The Code Table Media 
Codes Report lists the 
Media Codes set up in the 
system. 

Filters 
 Media Codes 
 Media Names 
 

 

 

 
 Fig. 147 
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CODE TABLE RECORD TITLES REPORT 

The Code Table Record Titles 
Report lists the Retention Codes 
for clients. 

Filters 
 Customer 
 Customer # 
 Record Title Code 

Order by 
 Client 
 Description 
 Record Title 

 
 Fig. 148 



 

Chapter 14 – Reports  Page 95 

The Tape Group 
The Tape Group, like the other categories, is 
accessed from the pull-down Report Category menu 
(right). 

 

     Fig. 149 
 

 

 

INTERIM TAPE INVENTORY REPORT 

This report selects and summarizes currently stored tapes by Tape Type broken out by Client. It 
defaults to printing in client name order. 

Filters 
 Client name 
 Client code 
 Tape Type 
 Department 

Order by 
 Client name (default) 
 Client code  

TAPE INVENTORY REPORT 

The Tape Inventory 
Report lists the tapes in 
Archive Manager.  

Parameters 
 Tape is in vault – 

Y/N 
 Page break by dept. 

– Y/N 
 Page break by box – 

Y/N    Fig. 150 

Filters 
 Customer 
 Customer # 
 Department 
 Major description 
 Received Date 
 Record Title Code 
 Rotation Date 
 Tape type 

Order by 
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 Box #  
 Cross reference 
 From date  
 List 
 Major description  
 Matter # 
 Tape # 
 Tape type 
 ID 
 To Date 

TAPE PULL LIST REPORT 

The Tape Pull List Report is very similar to a Box Pull List. 

Parameters 
 Page break by dept. – Y/N  

Filters 
 Customer 
 Customer # 
 Department 
 Major description 
 Received Date 
 Record Title Code 
 Rotation Date 

Order by 
 Box #  
 Cross reference 
 From date  
 Location 
 Major 
 Tape # 

TAPES CHECKED OUT REPORT 

This report lists all tapes currently checked out 

Filters 
 Customer 
 Customer # 
 Date out 
 Department 

Order by 
 Box #  
 Major 
 Tape # 
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TAPES DESTRUCTION NOTIFICATION REPORT 

The Tapes Destruction Notification Report informs your clients when particular tapes are eligible for 
destruction. It is based upon the Destroy Date provided by them. This report is set up similar to the 
Boxes Destruction Notification and Folder Destruction Notification reports.  
Filters 
 Box# 
 Customer 
 Customer # 
 Destroy Date  

Order by 
 Client name 
 Cross reference 
 Major 
 Minor 
 Tape # 
 

TAPES DESTROYED/ PERMANENT OUT REPORT 

The Tapes Destroyed / Permanent Out Report lists the tapes that have been destroyed or 
permanently removed.  
 
Filters 
 Customer 
 Customer # 
 Date Destroyed/ Permanently removed 
 Operation 
 Ticket # 
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Chapter 15 – Labels 
To access Archive Manager’s label feature, click Label on the Menu Bar, and select the label you want 
to print. The choices are: 

 Client address labels 
 Permanent (box) labels 
 Client labels 
 Folder labels  
 Shelf labels 
 Tape labels 

Shelf Labels 
This feature prints the 
bar coded labels that 
will be affixed to each 
shelf. The information 
on the labels comes 
directly from the 
information you 
provided at the 
Locations List screen 
(Fig. 16). The correct 
label size to use is 30 
labels to a page (i.e., 
Avery #5160). 

 

 

                  Fig. 151 

 

 

The Shelf Label printer 
provides three label 
numbering options: 

 Click the Exact location radio button to print a sheet of identical labels. 
 Click the Starts with radio button to print 30 consecutively numbered labels starting with the 

number you enter in the field to the right. 
 Click the Location range checkbox to specify a range of labels to print. 
It also provides for the starting position of the label (1 through 30) so you can reuse label sheets. 

After entering your preferences, click the Apply/show labels button. The labels will appear in the 
preview screen. To print the labels, click the printer icon and select your printer. 

Use the Search (binocular) button to find a specific label, and the Zoom (magnifying glass) button to 
adjust the display size. 
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Client Labels  
Client Labels are managed 
and printed from the Client 
Label screen (Figure 94). 
These labels are generally 
preprinted and provided to 
your client, who should be 
instructed to place a label in 
a prescribed location on 
each box before calling for a 
Pick Up. They contain a 
client name and bar code, a 
box bar code, and a 
department name (if 
applicable).  

 Fig. 152 

 NOTE: If your clients are 
using the optional Web 
Based Client Data Entry 
software,  
which requires them to 
key in their own Box and Folder Information, they should be instructed to input the number from 
the pre-printed label for each box as they enter their Box and Folder Information. 

To select a client for the labels, choose among the following: 

 Click the Client radio button to select a client from the scroll menu 
 Click the Client name starts with radio button to input the first letters of the client’s name. 
 Click the Client #  to input the client’s code 
 Click the Client # starts with radio button to input the first letters of the client’s code 
 
To include a department code on the label click Use Departments. 
 
To set the label numbers, either: 

 Click the Beginning with box # radio button to input the starting box number, or 
 Click the New labels checkbox to have Archive Manager print the number of consecutive labels 

you prescribed in # of labels box, beginning with the next unused box number in the system. 
Click the radio button to select either  

 6 labels per page; or  
 4 labels per page.  
Display and print the labels as described for Shelf labels, above.  
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 Process labels as printed? – flag these 
labels as printed? (right) 

 

Permanent Box Labels 
As each new box is keyed 
in to Archive Manager or 
uploaded from the 
Portable Bar Code 
Reader, the information is 
recorded in the Box Label 
file. Archive Manager 
does not print the labels 
while data is being 
entered, but waits until 
you open the Permanent 
Box Label screen (right) 
and run the permanent 
box label printing process.  

 Fig. 153 

Special permanent labels 
are custom manufactured 
in portrait format for 
Archive Manager.  
Boxes may be removed 
from the center for extended periods and then returned. Because permanent labels display specific 
pre-assigned box locations, they are more practical for use by record centers that reserve the open 
locations than for those that allow the Portable Bar Code Reader to reassign them.  
 Client and Location – these filters function as on the Permanent Client Label screen, above. 
 Starting pos – allows you to use a partially printed label sheet by selecting the staring position of 

the label 
 Include the following – these choices, which are self-explanatory, let you tailor the information 

on the printed labels to suit your needs. 
 Mark boxes as labeled – this control prevents these labels from being reprinted again in future 

runs. 
 All labels including processed – reprint previously printed labels 
 Sort by space # - labels automatically sort by location. This adds an additional sort. 
  
 
 Fig. 154 

 Label type – either: 
 Small, which displays basic information; i.e., box 

number, client bar code, and location; or  
 Big, which includes information from the box form, 

including box contents, department, and dates.   
 Labels per sheet –  

 6 labels per sheet; or  
 4 labels per sheet.     

Display and print the labels as described for shelf labels, above. When you are finished, the purge 
button will clear the file of all the processed labels.  Folder Labels 
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Folder Labels 
As each new folder is 
keyed in to Archive 
Manager or uploaded 
from the Portable Bar 
Code Reader, as with 
permanent box labels, 
the information is 
recorded in the Folder 
Label file. Archive 
Manager does not print 
the labels while data is 
being entered, but waits 
until you open the Folder 
Label Screen (right) and 
run the folder label 
printing process.  

                   Fig. 155 

The controls on this 
screen function very 
much like those on the 
Permanent Box Label 
screen, above. The choice of data to print, however, includes Major and Minor Description, and Matter 
no., which are used only for folders.  

There are filters for Location, Client, Ticket # range, Box # range, and Starting position. 

The labels are printed 6 to a page. 

Tape Labels 
The controls on this 
screen function very 
much like those on the 
Folder Label Screen.                     

Fig 156  

There are 2 formats for 
the tape label; 6 per 
page (shown) and a 
special 14 per page 
label (Avery 5262). 

The filters are the same 
as the folder labels 
above, but have been 
divided into 2 pages. 

Page 1 has Location 
and Client filters 

Page 2 has filters for 
Ticket #, Box #, and 
Starting position. 
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Client Address Labels 
These labels can be run for an individual client or all clients. These are very useful for mailing 
promotions (below). Client Address Labels 
 
 
 
 
 
 
 
 
 Fig. 157 
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Chapter 16 – Portable Upload 
Use of the optional Portable Bar Code Reader (left) with Archive 
Manager is simple and practical, and provides tremendous savings 
as compared to collecting data manually. Archive Manager 
downloads the collected data from the reader to a text file on the 
host PC as ASCII characters (unformatted text). A guide to the 
data format used in these files in located in Appendix B of this 
manual. 

To access the Portable Parser facility in Archive Manager, on the 
menu bar, click Portable > Portable. 

After you have scanned items and are ready to upload data, open 
the Portable Parser (Fig. 159, below) and follow the steps in the 
gray window.  

Fig. 158 

 

As Archive Manager reads the 
data, it appears in the window 
on the upper left. If you 
discover that you have 
scanned something 
incorrectly, you can modify 
the data manually here, or 
you can just continue reading 
the data. The upload is 
unaffected; Archive Manager 
ignores any errors and 
continues reading good items. 

When the data has been read, 
click Upload Data in the lower 
left of the upload screen. The 
lower window will fill with the 
uploaded information, and 
your data is saved to the 
database.  

 Fig. 159 

For a report on the uploaded data, go to the Reports module (Chapter 14) and run the Uploading 
Portable report. 

Uploading external data 
Many of our centers have become quite sophisticated with the portable reader and upload the bar 
code reader data to a text file. These text files may be uploaded by clicking on the Open file tab in the 
lower portion of the upload screen. You can then navigate through drives and folders to select your 
data file. Once selected the file appears in the window in the upper left and may be edited and 
uploaded as described above. 
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Chapter 17 – Import/Export of Client Data 

Importing Web Data Entry Batches 
Archive Manager’s optional Web Data Entry Client Software can be accessed on any number of your 
client’s PCs. Please see Appendix D for instructions. Please contact Record Management Software to 
purchase a software license. 

The Web Data Entry 
Software allows clients to 
enter Box and Folder 
information into a separate 
database on your server by a 
batch process. They then 
notify you by an email via 
Archive Manager’s Web-
based Client Data Entry 
Software.  

To open the Import/Export 
Module (right), click the 
Import icon in the activity 
pane’s shortcuts panel, or 
from the task bar menu, click 
Action>Export/ Import.  

Fig. 160 

 

 

After receiving a batch from 
Web Data Entry, click the 
Web Data Entry Import tab, you can then process the data as follows: 

1. First click View Boxes to see a grid of the boxes which can be edited.      Fig. 161 

. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. To the far right you can click View Folders to see the folders in that box and edit them. 



 

Chapter 17 – Import/Export Client Data  Page 105 

3. Finally, highlight the batch by clicking the arrow to the left of the batch # and click the Execute 
button at the bottom of the form.  You will be asked to navigate to the directory where the rejected 
boxes and folders will be saved in XLS format. The data will fill the lower white pane of the Import 
Window.  

When you have completed the process, it is a good idea to run the Import Client Data Entry Report 
(see Reports, Chapter 14) on the uploaded information. 

 

  

Importing a Clients’ Box/Folder Data 
After receiving and entering the boxes and/or folders or tapes in Archive Manager, via either the 
keyboard or the portable bar code reader, you can then process the data as follows:  

1. First, note Type, the 
format of the files that 
you are importing; either 
 Excel files (.XLS) 

2. Next, select whether the 
information is Boxes, 
Folders, Boxes/Folders, 
or Tapes. 

3. Finally, click the Execute 
button at the bottom of 
the form.  You will be 
asked to navigate to the 
directory where the files 
are stored. The data will 
fill the lower white pane 
of the Import Window.  

When you have completed 
the process, it is a good idea 
to run the Import Client Data 
Entry Report (see Reports, 
Chapter 14) on the uploaded 
information.             Fig. 162 

Note this utility also imports tapes. 

Manually entered boxes 

For standalone users and others who enter new boxes manually into Archive Manager, make sure that 
a proper location is entered in the Location field. The process is the same as above, except that the 
box will now be added to the system as a new box. 
 

Exporting a Client’s Box/Folder Data 
This feature is used to copy box and folder information; and tape information into Excel files for 
delivery back to your client. It can also be used to make a copy of the information as it now resides in 
Archive Manager for clients who have just licensed their use of the Web SIMPLE Records Manager.   

To export information, go to the Export Module (below) and follow this procedure: 
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1. The format for the files 
you are going to provide 
the client is shown in 
Type = Excel Export.  

2. Select Boxes/Folders, 
Boxes, Folders, or 
Tapes. 

3. Select the client or list, 
or enter the Client Code. 

4. Click the Execute button 
at the bottom of the 
screen and navigate to 
where you want to copy 
the data. 
  

 Fig. 163 

The files may be emailed or 
copied onto to a USB drive, 
for delivery to your client. 

NOTE: Remember that you 
are giving your client an 
electronic copy of their data, which may be used for import into most software programs – including 
those of your competitors. A precautionary alternative is to run a complete inventory report to a PDF 
file for your client (See Chapter 14, Reports) for clients who request an electronic copy of their data.  
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4. Finally, use the filters to 
select the new client 
code. This will auto-
matically change the 
folders associated with 
these boxes. 

 

Chapter 18 – Utilities 

Mass Change Clients 
The Mass Change Clients 
Utility is used to change the 
Client Code of multiple 
boxes to that of another 
client. It can operate on 
either a list, or on a group of 
boxes.  

One application for this 
would be if a partner of a 
client law firm left that firm 
and wished to set up his 
own account with you.  

1. In the Maintain Boxes 
screen, (right) select 
multiple boxes whose 
Client Code you want to 
change.  

2. Right-click to bring up 
the action menu; 

3. Click Utilities, then 
Change Client.  

(The new code must be for 
a pre-existing client.)  
  

 Fig. 164 

 
 

 Mass Change Departments 
This utility is used to change the department code of multiple boxes belonging to a specific client. It 
can operate on either a list, or on a group of boxes. The department having the code to which you will 
change must be an existing department for this client in Archive Manager, or a new one must be set 
up for the purpose. Mass Change Departments  

In the Maintain Boxes screen, select multiple boxes whose department code you want to change. 
Then follows steps 2 through 4 above, selecting Change Department instead of Change Client. 

Mass Change Box Description 
This utility is used to change the description of a group of boxes. It can operate on either a list, or on a 
group of boxes. In the Maintain Boxes screen, select multiple boxes whose department code you want 
to change. Then follows steps 2 through 4 as for the Mass Change Clients Utility, selecting Change 
Box Description instead of Change Client. 
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Mass Change Box Comments 
This utility is used to change the comments of a group of boxes. It can operate on either a list, or on a 
group of boxes. In the Maintain Boxes screen, select multiple boxes whose comments you want to 
change. Then follows steps 2 through 4 as for the Mass Change Clients Utility, selecting Change 
Comments on instead of Change Client. Note if you want to add onto to a set of comments, copy the 
original comments to the clipboard and then type the additional information into the dialogue window. 

Mass Change Locations 
This utility is used to change the location code of a group of boxes. It can operate on either a list, or on 
a group of boxes. In the Maintain Boxes screen, select multiple boxes whose location you want to 
change. Then follows steps 2 through 4 as for the Mass Change Clients Utility, selecting Change 
Location instead of Change Client. 

Recall Destroyed/ Permed Out Items 
The Recall Deleted Items utility is used to recall boxes that have been marked as destroyed or 
permanently removed from the center; as for example, if they were marked in error. It can operate on 
either a list, or on a group of boxes. 

In the Maintain Boxes screen, select the boxes you want to recall. The recall process is simpler when 
you work with a list - one reason why, when destroying or permanently removing boxes, it is advisable 
to create a list. Remember that the box filter must be set to All Boxes. Right-click to bring up the action 
menu, and click Recall From Destruction. This will automatically recall the folders associated with 
these boxes 

Match Box Department with Folders 
This utility changes the department code of all the folders in a box to match the department code of 
the box. It can operate on either a list, or on a group of boxes. In the Maintain Boxes screen, select the 
boxes you wish the folder department codes to match. Right-click to bring up the action menu, then 
click Utilities>Same Department For Folders.  

Reset Locations 
The Location List file keeps track of boxes as they are stored or removed from shelves. Occasionally, 
this file can be out of synchronization with the Box Inventory file. Archive Manager may then think that 
a space is open when, in fact, it is already filled. The Reset Location Utility updates the Location List 
file from the Box Maintenance file, automatically correcting any mistakes.  

Before running the Reset Location Utility, close all forms (especially any that are in Edit mode) and 
make sure you are the only user logged into Archive Manager. Then, from the task bar menu choose 
Security > Reset Locations. Press the Reset Locations button on the form to proceed. 

Defragment Database Utility 
This utility cleans the database and defragments it much like you would defragment a computer hard 
drive. The process will improve Archive Manger’s performance allowing it to operate more efficiently. 
We recommend running the Defragment Database Utility monthly. 

 Fig.165 
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Before running the Defragment Database Utility, close all forms (especially any that are in Edit mode) 
and make sure you are the only user logged into Archive Manager. Then, from the task bar menu 
choose Security > Defragment Database. Press the Defragment button on the form to proceed. 

 

 

 

Mass Destroy Utility 
This utility is for destroying or perming out large quantities of boxes. Note this utility requires significant 
server resources that it should only be run at off hours, preferably after a backup. 

 
Fig. 166 
After you search for some boxes and fill the maintain window, right click to Utilities > Destroy/Perm out 
all listed boxes. You do not have to click “Select All” or highlight the boxes. 
 
After a confirmation message you will choose the operation, person authorizing, and ticket #. 
 

Fig. 167
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Chapter 19 – Portable Bar Code Reader 
 

Overview 
For technical instructions about your Portable Bar Code Reader 
(right), please consult the user manual that came with it. It will 
discuss charging/ changing batteries, installing the hand strap, 
using the rubber case provided, technical specifications, etc.  

Instructions on uploading scanned data can be found in Chapter 
16 – Portable Upload. 

The current chapter will discuss use of the bar code reader for 
scanning with Archive Manager, and how its programming aids in 
managing your Clients’ records.  

Fig. 168 

The reader has been programmed to process new boxes coming in, boxes returning, folders being 
returned to their original box, moving folders from one box to another, and packing folders into a box. 
The scanning for these functions can be commingled, i.e., you can scan new boxes coming in, and 
then boxes returning, and then go back and scan some more new boxes coming In, etc. You do not 
need to upload the reader after each process; the reader keeps the data safely organized. When it is 
uploaded, Archive Manager processes everything that was scanned and stores the data, maintaining 
the organization. 

General Operation 

TURNING THE READER ON 

LT 5000 Turn the reader on using the On/Off key located in the upper left corner of the keypad. When 
the unit powers up, it displays TRICODER KT5000 – HW7 The exact message may differ from unit to 
unit. Press 1 for Data Collection. Program No.? Key [0-3]? Enter 1 for program 1. 

LT 54 Turn the reader on using the On/Off key located in the upper left corner of the keypad. When 
the unit powers up, it displays DMA TRICODER W2017 E – HIT ANY KEY. The exact message may 
differ from unit to unit, but the point is to hit any key to continue. It next displays Data collection? 
Key [Yes/No]? Press the Enter/ Yes key to the lower right of the keypad to enter the data collection 
mode. Program No.? Key [0-3]? Enter 1 for program 1. 

 NOTE: You will always use Program 1 unless directed otherwise by Archive Manager technical 
support. 

SELECTING THE PROGRAM 

If there is data in the scanner from a previous session, you will automatically be returned to the prompt 
you were at. For example: if you turn the reader off while scanning boxes returning (or it turns itself off 
after 5 minutes idle), when you turn the unit on again you will be prompted for Location, or whatever 
field you were in. You can then either continue scanning boxes returning or press the End key located 
on the right side of the keypad to hear the menu choices. If the reader is not storing data (meaning 
previous data was uploaded) you will then be asked, Program No.? Key [0-3]?. 
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READER MENU ITEMS 

Program 1 provides for functions regarding boxes and files. 

Box Menu 

 New Boxes 
 Check Out Boxes 
 Check In Boxes 
 Move Boxes 
Folder Menu 

 New Folders 
 Move Folders 
 Box Folders 
 Check In Folders 
 Check Out Folders 
When you are in any of these functions and wish to return to the Menu, press the End key on the right 
side of the keypad. If you want to leave the menus and turn the reader off, answer NO to each of the 
Menu items until you hear, “Finished?”, then enter Yes. Or you can press the F1 function key on the 
top row of the keypad, which will return you to the Data collection? Key [Yes/No]? display. You can 
then just turn the reader off. 

VOICE PROMPTING  

The reader is programmed for audio. Thus, as each prompt appears in the window of the reader you 
will hear what you are supposed to scan. If you want to turn the voice portion OFF, proceed as follows:  

1.  Press SHIFT key and Release 
2.  Press F1 key and Release 
3.  Press S key and Release 
If you want to turn the voice portion ON do the following: 

4.  Press SHIFT key and Release 
5.  Press F1 key and Release 
6.  Press V key and Release 

SCANNING A BAR CODE 

To scan a bar code, point the reader at the label and squeeze the trigger or press the green bar just 
above the keypad (older models). For most users, resting your thumb on the bar and pressing as 
needed seems to be the most comfortable way of using of the reader. When the green bar is pressed, 
the laser beam will project from the top of the reader.  

 

 DANGER! NEVER look into the beam! 

 

It may take some practice to hold the reader in the right position so that the beam hits the bar code 
correctly. The reader is designed so that you can look at the reader’s window while scanning a bar 
code. This way, you can see in the window what was just scanned. You will consequently be holding 
the reader tilted slightly upward rather than pointing exactly at the bar code. Just be sure the laser 
beam extends clear across the bar code and overlaps on both sides. Box 
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Box Menu 

NEW BOXES 

When you hear, “New boxes?” and answer Yes by pressing the Enter Key, the reader displays Box, 
and you will hear the word, “Box” spoken. 

Overview of New Box Entry Procedure  
 
After locating a shelf onto which new boxes can be put, turn on the reader, choose Program # 1, and 
then go to Data collection.  

If you already have data in the scanner, you will automatically be returned to your previous prompt, as 
described above.  

If there is no data in the scanner you will be prompted to select a function, i.e., New boxes?, Boxes 
returning?, Folders returning?, Finished?. Choose New boxes by pressing the green ENTER/YES 
key.  

1. Assigned Box: The reader first prompts you for the Assigned Box Number. Scan the Assigned 
Box Number bar code on the label. 

2. Client Number: The reader next prompts you for the Client Number. Scan the client bar code on 
the label. 

3. Department: The reader will next prompt you for the Department Number. Scan the Department 
Number bar code on the label. This field may often be empty, as not all clients will want to track 
their boxes by department. If empty, you can either scan the bar code or press the green Enter 
key. 

4.  Location: The reader then prompts you for the Location. Scan the bar code on the shelf onto 
which your first box is to be placed. 

 
When finished scanning the Location bar code, the reader will automatically return to the Box prompt.  

If you are putting more than one box onto the same shelf you can either scan the shelf label again, or 
you can press the Enter key and the reader will recall the last shelf scanned. So, if you are storing 30 
boxes for the same department, you need to scan the department bar code only once. But always 
remember to scan a new department bar code when you switch to another department. NOTE: This 
feature works similarly in all the fields. 

When finished scanning all new boxes, you can press the End key and you will head the next menu 
prompt, “Boxes returning?“ 

You can scan new boxes and stop – and then, without uploading, you can scan boxes returning, or 
folders returning.  

When you are finished scanning, you can upload the reader at your convenience. 

Boxes Check out 
When you hear “Check out box?” and answer Yes by pressing the Enter key, you will receive a 
visible and audible “Box” prompt.  

Assigned Box Number 
At the Box prompt, the Assigned Box Number is scanned from the box label. When you are finished 
checking out boxes and ready to go to the Menu, press the End key. 

Person  
This prompts you to scan or type in the name of the person to whom the box is being checked out.  
Boxes Returning 



 

Chapter 19 – Portable Bar Code Reader  Page 113 

Boxes Returning 
When you hear, “Check in box?” and answer Yes by pressing the Enter key, you will again receive a 
visible and audible “Box” prompt.  

Assigned Box 
At Boxes Returning Box prompt, the Assigned Box Number is scanned from the box label, as above. 
When you are finished returning boxes and ready to go to the Menu, press the End key. 

Location 
At this prompt, Archive Manager expects you to scan the bar code label on the shelf onto which you 
will be placing the first of the returned boxes.  

Move Boxes  
The Move Boxes prompt allows you to scan boxes that are already in the database to new locations, 
and generates the necessary audit trail. 

When you hear, “Move box ?” and answer Yes, you will receive a visible and audible “Box” prompt.  

The Assigned Box and Location prompts function similarly to those prompts in Boxes Returning. 
Folder Menu 

Folder Menu 

NEW FOLDERS 

This function is used when putting new folders into boxes. The prompts are: 

 File # 
 Box # 
 Client  
 Dept. 

MOVE FOLDERS 

This function is used when putting moving existing folders into different boxes. The prompts are: 

 File location 
 File # 

FOLDERS RETURNING 

This function is used when folders are returned to their boxes. When the bar code reader is uploaded 
and the scanned information processed, you will receive a report. If you have accidentally put a folder 
into the wrong box, the report will show this as an error. In this event, the error should be corrected 
immediately. The prompts are: 

 Client 
 Box # 
 File # 
  
There is also a routine to check in folders and verify the box. The voice prompt is “Check in Folder 
Against Box”. The prompts are: 

 Client (from the folder label) 
 Box # (from the folder label) 
 File # 
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 Client (from the box label) 
 Box # (from the box label) 
 

CHECK OUT FOLDERS 

This function is used when retrieving Folders from Boxes. The prompts are: 

 File # 
 Person - This prompts you to scan or type in the name of the person to whom the folder is being 

checked out to. 
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The Web Client Data Entry 
Software has options that  
allow clients to update the  
information for boxes already in 
your records center, and to enter 
folders for boxes already in your 
center; switches can be set in the 
software to turn these options on 
and off.  

The software also prints box and 
folder manifests for all new items 
going to your record center, and 
there are additional reports to 
permit clients to edit the data they 
are submitting.  

 

Chapter 20 – Optional Modules 

Web Based Client Data Entry 
Software 

Archive Manager’s Web based client 
data entry software (right and Appendix 
D) is a package that is installed onto a 
web server either at your office or hosted 
by us. Once licensed, you have the right 
to grant access to Web Data Entry to as 
many of your clients as desired. You can 
even charge a fee to help offset the cost 
of Client Data Entry.  
 

 

 

 

 

 

 

 
 

Fig. 169 

 
 

Updated versions of the software can be downloaded from our Web site as they become available. 
Please call for current pricing.  Optional Modules 
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Web Access 
The Web Access module (Figure 170, below, and Appendix C) allows clients to access their records 
via the web and to check out items any time at their convenience. This is truly indispensable for 
servicing large volume clients. When clients need an item, they log into your server using their Internet 
browser and query their box, file, or tape information. Archive Manager quickly responds, telling them 
either that the item is available, or that it is currently checked out, and to whom. 
 
Appendix C, Sections 1 and 2, below, provide detailed information about use of the Web Access 
module. 
 
Section 1 explains how to set up Web Access in Archive Manager at the archive storage facility. 
 
Section 2 explains to customer how to use the Web Access module to access records and check out 
items via the Web. 
 

 
  
 Fig. 170 
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Appendix A – Field Definitions 
Assigned Box Number: a 9 position, numeric field containing the number assigned to a given Box. 
Archive Manager can automatically assign this number for manually entered Boxes. A code in the 
Setup file determines if each box must have a unique Assigned Box Number, or if numbers can be 
reused between clients (but never within a given client). 

 

Being Held: a code placed into the Box and/or Folder database to indicate the items cannot be 
destroyed. 

 

Billing-State: a 2 position alpha field in the Client Master file that contains the State portion of the 
billing address. 

 

Billing-Address 1: a 30 position, alpha/numeric field in the Client Master file that contains the first line 
of the billing address. 

 

Billing-Address 2: a 30 position, alpha/numeric field in the Client Master file that contains the second 
line of the billing address. 

 

Billing-City: a 20 position, alpha/numeric field in the Client Master file that contains the City portion of 
their billing address. 

 

Billing-Contact: a 30 position, alpha/numeric field in the Client Master file that contains the individual 
to whom the Invoice should be addressed. 

 

Billing-Invoice Number: a number generated automatically for each invoice in the format  
xxxx-y-zzzzz where the first invoice for March 2013 would be 2013-1-00001, as follows: 

x is the 4 digit year, 
y is the last month (1 for January, 12 for December), and 
z is a 5 digit number with leading zeros (starting with 1 for each month). 
 

Billing-Telephone Number: a 14 position numeric field in the Client Master file that contains their 
billing telephone number. 

 

Billing-Terms: a 20 position, alpha/numeric field that contains the wording of the Terms. Example: 
“Now Due and Payable, Net 10 Days.” Can be different for each client.  

 

Billing-Zip Code: a 10 position numeric field in the Client Master file that contains the Zip Code 
portion of their billing address. 
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Billing Code: a 2 position, alpha/numeric field used to describe a particular service performed. 

 

Billing Description: a 40 position, alpha/numeric field used to define each Billing Code. The 
information entered here will appear on the Invoice. An example would be a Billing Code for entering 
new boxes received. It might read ‘Indexing New Boxes and Files.’ 

Billing Rate: 
This is a 10 position numeric field containing 4 decimal places. It contains the rate that will be charged 
for a specific Billing Code. The reason for having 4 decimal position is to allow for charging a very 
small rate, like .002 cents per image for scanning and making microfiche. 

 

Box Description: a 50 position, alpha/numeric field containing a brief description of what is in the 
Box. 

 

Box Size Code: a 4 position, alpha/numeric field. A code placed into the Box Inventory to indicate the 
size of the box. The computer automatically takes this information from the Location Master File as the 
Box is entered into Archive Manager. 

 

Box Size Description: a 30 position, alpha/numeric field describing the Box Size. Example: Standard 
Size Box, Transfer Case, etc. 

 

Client-Company Name: a 30 position, alpha/numeric field in the Client Master file and is used to 
enter your client’s company name. 

 

Client-State: a field in the Client Master file that contains the State portion of their address. 

 

Client-Address 1: a 30 position, alpha/numeric field in the Client Master file that contains the first line 
of their business address. 

 

Client-Address 2: a 30 position, alpha/numeric field in the Client Master file that contains the second 
line of their business address. 

 

Client-Attention Of: a 30 position, alpha/numeric field in the Client Master file that contains the 
individual to whom the Invoice should be addressed. 

 

Client-Billing Rate: a 10 position numeric field containing 4 decimal places. It contains the rate this 
client will be charged for a specific Billing Code. The reason for having 4 decimal position is to allow 
for charging a very small rate, like .002 cents per image for scanning and making microfiche. 
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Client-Billing Representative: a 20 position, alpha/numeric field that contains the name of the 
individual in your company the client should call if they have any questions regarding the Invoice. 

 

Client-Canada GST tax: a coded field that tells the computer you need to calculate, invoice and 
collect the Goods and Services Tax for your client in Canada. 

 

Client-City: a 20 position, alpha/numeric field in the Client Master file that contains the City portion of 
their address. 

 

Client-Department Indicator: a coded field that tells the computer if the client wants to track their Box 
Inventory at the Department level. 

 

Client-Exempt Code: a coded field that tells the computer this client is exempt from sales tax. Even 
though you may engage in a taxable transaction (sell new Boxes as an example) sales tax will NOT be 
added to this charge. 

 

Client-Minimum Storage: a 6 position numeric field used to record what, if any, minimum storage fee 
should be applied to this client. This can be different for each client. 

 

Client-Number: a 10 position, alpha/numeric field containing the number assigned to each client.  

Client-Storage Indicator: a coded field that tells the computer what billing cycle the client is on - 
monthly, quarterly, or annually. 

 

Client-Telephone Number: a 14 position numeric field in the Client Master file that contains their 
Business telephone number. 

 

Client-Type Billing: a coded field that tells the computer whether the client is paying per cubic foot or 
per box. 

 

Client-Zip Code: a 9 position, alpha field in the Client Master file that contains the Zip Code portion of 
their address. 

 

Contract Number: a 10 position, alpha/numeric field used to enter the client’s contract or purchase 
order. This information is printed on the Invoice. 

 

Contract Begins: a date field used to record the beginning date of the contract. This information is 
only used if the client is being billed annually for storage. If they are paying annually, Archive Manager 
looks at the month portion of this date to determine when to include next year’s storage on their 
invoice.  
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Contract Ends: (not currently used) 

 

Cost Per Box: a 10 position numeric field containing 4 decimal places. It contains the rate that will be 
charged for a specific size box. 

 

Cross Reference: a 15 position, alpha/numeric field into which you can enter your client’s box 
number. 

 

Cubic Feet: a 9 position numeric field containing 4 decimal places indicating the number of cubic feet 
a specific size box contains. 

 

Date In: a date field used to record the date a Box or Folder is Returned. 

 

Date Out: a date field used to record the date a Box or Folder is checked Out. 

 

Date Received: a date field; only valid dates can be entered. Used to record the date the Box or 
Folder was received into your records center. Also used when calculating prorated current month 
storage. 

 

Department Number: a 10 position, alpha/numeric field containing the number assigned to each 
clients department. When setting up the client Master you need to indicate the department number is 
required. And you must also enter each valid department for this client in the client Department Master 
File. 

 

Destroy Date: a date field used to describe the month, day, and year the Box can be destroyed. 
Supplied by the client or the computer will automatically put 12/31/9998 into the field. 

 

Duplicate Box Number: a code in the Setup file that is used to indicate how you want to validate 
each Box Number. One option will check each Assigned Box Number and will NOT allow any two 
boxes to exist with the same number. Another option allows for two or more boxes to have the exact 
box number but each of those boxes must belong to a different client. In other words, no client can 
have the same two box numbers. 

 

Folder Number: a 4 position numeric field used to identify each Folder in a Box. This number is 
automatically entered by Archive Manager at the time Folders are entered. The can be a maximum of 
9999 Folders in any one Box. 

 

From Date: a date field, only valid dates can be entered. Used to describe the beginning range of 
dated information in a given Box or Folder. 
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ID Number: a 5 position, alpha/numeric field used to record an addition piece of information about a 
Folder. Example: A law firm may use this to record the initials of the attorney responsible for this case, 
i.e., DBC 

 

Location: an 11 position, alpha/numeric field used to describe each shelf in the records center. 

 

Major Description: a 50 position, alpha/numeric field used to describe information about a Folder.  

Example: A law firm might use this field to describe their client, SMITH vs. JOHNSON. 

 

Matter Number: a 13 position, alpha/numeric field used to describe additional information about a 
Folder. Example: A law firm may use this to record the Case Number, I.e., ABC1234 

 

Media Code: a 3 position, alpha/numeric field used to identify what is in each Box. If used, you need 
to enter all of the valid Media Codes into the Media Code Master File. 

 

Minor Description: a 50 position, alpha/numeric field used to describe more information about a 
Folder.  

Example: A law firm may use this field to indicate a brief description of the case, i.e., REAL ESTATE 
CLOSING. 

 

Password: a 15 position, alpha/numeric field used to enter information known only to the individual to 
whom it has been assigned and is used to gain access to the software. 

 

Prorate: a code used to indicate when the charges for a specific Billing Code will be calculated from 
the date received until the end of the month.  

 

Purchase Order Number a 10 position, alphanumeric field used to enter the client’s contract or 
purchase order. This information is printed on the Invoice. 

 

Quantity: 10 position numeric field with 2 decimal positions. It is used to record the number of 
services performed for a given work order/billing code. Example: If you are charging the client for 
picking up 25 Boxes the “quantity” would be 25. 

 

Record Title Code: a 10 position, alphanumeric field containing information supplied by your client 
about a series of boxes. 

 

Return By: a date field used to record the date a Box or Folder is to be Returned. 



 

Appendix A - Field Definitions  Page 122 

Sales Tax Indicator: a code used to indicate when a specific Billing Code is subject to sales tax. 

 

Space on Shelf: a 2 position numeric field used to record the actual space on the shelf. In most cases 
it is automatically assigned by the computer as the bar code reader is uploaded. 

 

Save Location: a code in the Setup file that is used to indicate if you are Reserving the space when a 
Box is checked out or if you are operating in a Random method. 

 

Setup Account: The income account that charges will be transferred to in QuickBooks. 

 

Tax Rate: The sales tax rate charged to a specific customer expressed in decimals. For example 
6.5% would be entered as .065. 

 

Ticket Date: a date field and is used to indicate the date of the service on a given ticket or work order. 

 

Ticket Number: 6 position, alpha/numeric field used to record a Work Order relating to a specific 
charge. 

 

To Date: a date field; only valid dates can be entered. Used to describe the ending range of dated 
information in a given Box or Folder. 

 

Unit of Measure: a 6 position, alphanumeric field used to give meaning to the service being 
performed. It is entered into the Master Billing Code file and automatically placed onto any screen 
where Charges are involved. An example would be a Billing Code used to charge for data entry 
services at 35.00 per hour. The Unit of Measure in this case is ‘Hours’.  

 

User ID : a 10 position, alphanumeric field used to enter information known only to the individual to 
whom it has been assigned and is used to gain access to the software. 

 
Work Order: See ticket #- 6 position, alpha/numeric field used to record a Work Order relating to a 
specific charge. 

 

WWW: Your web address URL. 

 

Your Address: a 30 position, alphanumeric field in the Setup file that contains the first line of your 
business address. 



 

Appendix A - Field Definitions  Page 123 

Your City: a 30 position, alphanumeric field in the Setup file that contains the City portion of your 
address. This information appears on the bottom of each report. 

 

Your Name: a 30 position, alphanumeric field in the Setup file that contains your Name. This is the 
name that appears on the bottom of each report. 

 

Your State: a 2 position alpha field in the Setup file that contains the State portion of your address. 
This information appears on the bottom of each report. 

 

Your Telephone Number: a 14 position numeric field in the Setup file that contains your Business 
telephone number. 

 

Your Zip Code: a 10 position numeric field in the Setup file that contains the Zip Code portion of your 
address. 
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Appendix B – Portable Codes 
KEY: REQ = required field    IMP = field that can be imported from the previous operation 
 
Boxes 

Boxes returning: 
BI-B - Box# - REQ 
L - Location Code - (if missing, return to the same Location) 

 
Boxes checkout: 
BO-B - Box# - REQ 
P - REQ, IMP 

 
Move box to a new location: 
BM-B-Box# - REQ 
L - Location Code - REQ, IMP 

 
New Boxes: 
BN - B-Box# - REQ 
C - Client Code - REQ, IMP 
D - Dept Code - IMP 
L - Location Code - REQ, IMP 
 
New Boxes with cross reference: 
BN - B-Box# - REQ 
C - Client Code - REQ, IMP 
A – Cross Reference - REQ 
L - Location Code - REQ, IMP 

 

Folders 
Folders Returning: 
FI- C- Client- REQ -IMP 
B - Box# - REQ, IMP  
F - Folder Number - REQ 
 
In our current implementation, you can return a folder only to the box from which it was taken (box 
identification is a part of folder identification. If a folder is returned to a different box, Archive 
Manager can not track it and there will be no Audit Trail. You must make absolutely certain that 
the destination box belongs to the same client as the folder, since folders are identified by their 
boxes.  

Folders Check Out: 
 FO - B-Box# - REQ 

F - Folder# - REQ, IMP 
P -  person 
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Folders Move: 
FB-O - OldBox# 
F- folder# 
N - New box # 
P - Person REQ, IMP 
This operation moves a folder from one box to another one owned by the same client. You must 
make absolutely certain that the destination box belongs to the same client as the folder, since 
folders are identified by their boxes.  

New Folders: 
 FN-F – Folder# 
 B - Box# 

C - Client Code - REQ, IMP 
 D - Department Code - IMP  
 L - Location Code - REQ, IMP 

Tapes 
Tapes Returning: 
TI- C- Client- REQ -IMP 
B - Box# - IMP  
T - Tape Number - REQ 
 

Tape Check Out: 
 TO - B-Box# - REQ (only for boxed tapes) 

T - Tape# - REQ, IMP 
P - Person 

Tapes Move: 
TL-T - Tape# 
L - Location Code - REQ, IMP  

New Tape: 
 TN-T – Tape# 
 B - Box# 

C - Client Code - REQ, IMP 
 D - Department Code - IMP  
 L - Location Code - REQ, IMP 
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Appendix C – The Web Access Module 

Section 1 – Record Center Instructions 

TECHNICAL REQUIREMENTS 

The Web access module runs on a Windows 2016 server or higher, and requires a static IP address. 

To host the module you can use either your own in-house server, or a commercial web hosting 
service. 

NOTE: If you plan to plan to host the Web Access Module privately, note that  IIS 7.5 is deployed  with 
a static IP address. Please call for technical assistance and pricing. 

If you are hosting the Web Access Module privately, after it is installed at your server, have your Web 
administrator add a link to your Login URL on your home page. When your customers are ready to use 
the Web Access Module, they can simply click the link to access the Login page, enter their username 
and password, then click Login.  

SETTING UP THE WEB ACCESS MODULE IN ARCHIVE MANAGER 

If a Contact has previously been set up for the customer in question, the Web Access Module uses the 
contact’s existing user name and password and no further setup is required (see The Contact Screen, 
Page 19). Otherwise, simply create a contact for the customer, with a user and password. The 
procedure you use will depend on whether departments have been set up for the particular customer 
in the Maintain Clients screen. 

• Customers without departments: refer to Page 19, The Contact Screen.  

• Customers with departments: refer to Page 21, The Department Contact Screen.  

At the Maintain Clients screen, select a client and click Edit, or else double-click the client to view the 
client entry in the Current Client screen. 

When users at non-departmentalized customer sites request items for check out, Archive Manager will 
use the customer’s main address for the delivery ticket.  

Once your customer’s contacts have a user name and password, all they need is their web browser to 
log in. They will typically go to an address that you will provide, like 
http://your_ip/AMWebAccess/Login.aspx, to log in.  
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WEB ACCESS RETRIEVALS 

 

You will be notified in several ways that a new Web access order is pending:  

 an email will be sent to your account from your SMTP server, and 
 a message will pop up in the lower right-hand corner of your screen, or  
 a message will appear in the message box above the maintain menu.  
 
After receiving notice that a new Web Access was received, go to Maintain Orders (Chapter 11) and 
filter on the ticket number given in the notification. For a Web Access order, this number always begins 
with “WEB”, so it would be practical to click the filter labeled “Web order’.  

Fig. 171 

Just process the order as you 
normally do per Chapter 11. This 
will allow you to charge for the 
order and print your delivery ticket 
and pull list. 

 

 

 

 

 

 

 

 

 

 

 

 
 
Setting Up “Supplies & Materials” for the Maintain Orders Module  

The Web Access module includes a Supplies & Materials list that is populated from your master 
billing codes. See Billing Codes in Chapter 2 Getting Started. While you are setting up Web Access, 
you should select the items your clients will see on the Supplies & Materials list.  

To do this, proceed as follows: 

1. Log into Web Access using the admin password supplied by Record Management Software. 
The Billing Code Menu icon appears. 
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Fig. 172 

 
2.  Select Billing Codes List; the Choose Billing Codes screen appears.  

 In the list of billing codes, click on the items that you want to appear on the pull down list for 
your client.  

 Selected items appear with a green check; unselected items appear with a red check.   
 

 
Fig. 173 

Your clients will now see the selection you created when they order supplies and materials using Web 
Access. 
 
The supplies and materials will appear in the Web order on the Non Item Billing Codes tab. 
 
 
 
 
 
 



 

Appendix C – The Web Access Module  Page 129 
 
 
 

Section 2 – End User Instructions 

WELCOME TO THE ARCHIVE MANAGER WEB ACCESS MODULE! 

Archive Manager’s Web Access Module was designed to be intuitive and easy to use. Follow the 
instructions in this section to set up your account, to access your records, or to request services. 

SET UP A USER 

Before your firm can use Archive Manager Web Access, you must contact your archive service 
provider and designate persons who will be the authorized Web Access users. The archive service 
provider will assign each person a user name and password for logging into the Web Access system. 
Your firm may designate as many users as desired. Moreover, if your firm has multiple departments, 
each can designate its own users.  

NOTE: Users may be granted access to their own department’s records only, or to global access to 
records of all departments. When setting up contacts with your archive service provider, remember to 
specify which type of access is desired for each user. 

LOGGING IN 

Fig. 174 

 

To access the Login Page, go to your archive service’s home page and click the link for Archive 
Manager Web Access. The login page will appear. 

Simply enter the User Name and Password, and click Login. 

 

The Web Access Menu will appear, offering eight choices of action: 

 Super search filter (Contents) 
 Boxes 
 Folders 
 Tapes 
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 Supplies & Materials 
 View Order 
 Save Order 
 Email Us 
 Help (User Guide) 

  
    Fig. 175 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

GENERAL NAVIGATION 

As you click on the choices, at the top of all the lists you will notice tabs for your open windows for 
boxes, folder, tapes, view order, and supplies & materials. You can just click these tabs to navigate 
between all the open windows. Your filter settings will remain as you jump from window to window. 
And when you log out, the windows will automatically close.
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Boxes 

 
Select Boxes to look up and check out boxes.     Fig.176 

The View Boxes screen appears, sorted by default on the Description field.  

Searching for boxes 
You can search for boxes by a number or phrase in various categories, which can be used in 
conjunction: 
 Box Contents 
 Box Number 
 Box Number To 
 From Date 
 To Date 
 Department 
 Cross-Reference 
 Comments 
To perform a Search, type the number or phrase on which you are searching in the appropriate filter 
and click the Search button. To clear your selection, click Clear Filters. 

Note if your password is limited to one particular department, the department filter will be filled in with 
department code and cannot be erased or altered. 

If you need to indicate one or more missing characters in your search, you can 
use % as a wild card. For example, if you were searching for a Description like 
"2019 or 2020 Sterling Closing", and couldn't remember exactly whether the 
closing occurred in 2019 or 2020, you could enter "% Sterling Closing" to display 
all existing possibilities. For the Comments filter, the wildcard is automatically 
applied. 

To use the From Date and To Date filters, click on the ellipse to the right of those 
filters to bring up the date dialog box. The From Date filter will select all boxes greater than or equal to 
that date. The To Date filter will select all boxes less than or equal to that date. 
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A symbol legend appears at the top of each Web Access screen. In Boxes:  

 Green dot – box is currently in the record center. 
 Red dot – box has been checked out. Clicking on the red dot displays the Checkout Window, 

where you can see who checked out the box. 
 Yellow dot – box has been requested for check out.  
 

Comments 
To see comments for a box, click on the box number or the comments text to see the complete data. 

Sorting 
All Web Access forms may be sorted by clicking on the column heading. The first click puts the items 
in ascending order under that heading. A second click puts the items in descending order.  

Checkout  
To check out a box, simply locate and select the desired item and click the Green dot at the left. A 
Yellow dot will appear in its place and the box has been added to the order.  

If you have selected a box in error, simply click the Yellow dot to the left to remove the request. 
Because your company, name, and address are identified when you log in, there is nothing further to 
do.  

To see who has 
a checked out 
box, click the 
Red dot at the 
left. A box will 
appear with the 
name of the 
person and the 
date that he/she 
checked out the 
box. 

  

 

 

 Fig.177 
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Reports 

 
On each of the View screens, when the filtered list is displayed, you can click the Show Report button 
to generate a screen report of the filtered and sorted list. You can then export the report to a PDF file 
by clicking the Save button at the lower right of the screen. To print all items, leave the filters blank.       
Fig 178 

     

FOLDERS  

 
Fig. 179 

Click the folder icon to the right of a box to see all of the folders within that box. Only boxes with 
folders will have the icon. The Folders screen appears, sorted by default on the Description field. Or 
click Folders on the left menu. 

In this screen you can look up and check out.  
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Searching for folders 
You can search for folders by a number or phrase in one of the following categories, which can be 
used in conjunction: 

 Major description 
 Minor description 
 Folder number 
 Matter 
 Box number 
 Department 
 Cross Reference 
 ID 
 Comments 
To perform a Search, type the number or phrase on which you are searching in the appropriate filter 
and click the Search button. To clear your selection, click Clear Filters.  

As when searching for boxes (above), if you need to indicate one or more missing characters in your 
search, you can use % as a wildcard, except the Comments filter, where the wildcard is automatically 
applied. 

A symbol legend appears at the top of each Web Access screen. In Folders:  

 Green dot – Folder is currently in the record center. 
 Red dot – Folder has been checked out. By clicking on the red dot, you can view the checkout 

window as to whom the folder has been checked out to. 
 Orange dot – Folder is in a box that is checked out. 
 Yellow dot – Folder is scheduled for delivery. 
 

Comments 
To see comments for a folder, click on the folder number or the comments text to see the complete 
data. 

Sorting 
All Web Access forms may be sorted by clicking on the column heading. The first click puts the items 
in ascending order under that heading. A second click puts the items in descending order.  

Checkout  
To check out a folder, simply locate and select the desired item and click the Green dot at the left. A 
Yellow dot will appear in its place and the folder has been added to the order.  

If you have selected a folder in error, simply click the Yellow dot to the left to remove the request. 
Because your company, name, and address are identified when you log in, there is nothing further to 
do.  

To see who has a checked out folder, click the Red dot at the left. A box will appear with the name of 
the person and the date that he/she checked out the folder. 

Reports 

Like Boxes, when the filtered list is displayed, you can click the Show Report button to generate a 
screen report of the filtered and sorted list. You can then export the report to a PDF file by clicking the 
Save button at the lower left of the screen. To print all items, leave the filters blank. 
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TAPES  

 
Fig. 180 

You can search for tapes by a number or phrase in one of the following categories which can be used 
in conjunction: 

 Major description 
 Minor description 
 Tape number 
 Matter 
 Box number 
 Tape type 
 Cross Reference 
 Department 
 Comments 
To perform a Search, type the number or phrase on which you are searching in the appropriate filter 
and click the Search button.  To clear your selection, click Clear Filters. 

As when searching for boxes (above), if you need to indicate one or more missing characters in your 
search, you can use % as a wildcard, except the Comments filter, where the wildcard is automatically 
applied. 

 

Symbols 

 Green dot – Tape is currently in the record center. 
 Red dot – Tape has been checked out. By clicking on the red dot you can view the checkout 

window as to whom the tape has been checked out to. 
 Orange dot – Tape is in a box that is checked out. 
 Yellow dot – Tape is scheduled for delivery. 

 



 

Appendix C – The Web Access Module  Page 136 
 
 
 

Comments 
To see comments for a tape, click on the tape number or the comments text to see the complete data. 

Sorting 
All Web Access forms may be sorted by clicking on the column heading. The first click puts the items 
in ascending order under that heading. A second click puts the items in descending order.  

Checkout  
To check out a tape, simply locate and select the desired item and click the Green dot at the left. A 
Yellow dot will appear in its place and the tape has been added to the order.  

If you have selected a tape in error, simply click the Yellow dot to the left to remove the request. 
Because your company, name, and address are identified when you log in, there is nothing further to 
do.  

To see who has a checked out tape, click the Red dot at the left. A box will appear with the name of 
the person and the date that he/she checked out the tape. 

Reports 

Like Boxes, when the filtered list is displayed, you can click the Show Report button to generate a 
screen report of the filtered and sorted list. You can then export the report to a PDF file by clicking the 
Save button at the lower left of the screen. To print all items, leave the filters blank. 

 

 

SUPER SEARCH FILTER 

Filling in text in the field labeled Search Filter, allows you to search all modules at once. If not already 
open, the tabs for boxes, folders, and tapes will automatically open and search for any matching 
characters within: 

Boxes  

 Box Description 
 Comments 

Folders 

 Major Description 
 Minor Description 
 Comments  

Tapes 

 Major Description 
 Minor Description 
 Comments  

 
NOTE: The Super Search Filter requires that you enter the text from its beginning. If you are searching 
for part of a text, use the wildcard key %. The wildcard character is %, meaning “accept any value”. It 
may be used in any part of a query. It may be used with any of the text filters as a key word search. 
The comments field does not require a wildcard and will search for any embedded text string. For 
example %JONES in a description finds all files with the phrase JONES such as SUSAN JONES or 
SMITH and JONES. 

 
After entering text to search for, click the magnifying glass symbol. You will then have the results 
page. You can then click on the boxes, folders, and/ or tapes tabs to see the actual data found. 
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Fig.181 

SUPPLIES & MATERIALS 

Before saving your order, 
click the Supplies & 
Materials button on the 
Menu to add materials to 
the order. You may 
choose from a list to order 
boxes, bar codes, and 
other supplies. These will 
be added to your order. 

Fig. 182 

The options on this list are determined by your record center. If a desired option is not offered, contact 
the center to request that the item be added.  

NOTE: The administrator setup procedure for this feature is discussed in Section 1 of this Appendix. 
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THE VIEW ORDER SCREEN 

 
Fig. 183 

 

The View Order screen lists the items you requested for checkout for your review.  

Three lists are displayed; first boxes, followed by folders, and then tapes.  Then there is a section for 
the supplies and materials ordered. 

An Order Comments note field allows you to enter any amount of text. 

To remove any item from the order, simply click on the Yellow dot. 

Click the Print order icon to print a copy of the order for your records. 

After the check out process is completed by clicking the Save Order button, the View Orders Selected 
Items list is cleared. 

SAVE ORDER 

When you have finished making 
your selections, remember to click 
the Save Order button on the left 
menu.  

This dialog box also appears if 
you accidentally try to log out 
without saving the order.       

   Fig.184 
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Clicking the button generates a confirmation that the order has 
been processed and can send an email such as the following to 
the user. As well, the record center receives an email, indicating 
that your order is ready to be processed.    
     Fig. 185 

 
 
 
 
 
 
 
 
 
 
Subject: Message from the records center 
 Dear BOB SMITH,  
 
This is a confirmation message from AM Web Access 
 
Your order has been received. 
 
Please do not reply to this message 
 
Thank you,  
RMS ARCHIVES 

 
New order from LEVEN & TAYLOR 
 
Ticket no:         WEB00003081 
Requested by: BOB SMITH 
Tel no:         N/A 
Address:         2000 FENWAY BLVD 

EMAIL US 

Clicking on the Email Us opens a new message from your default email client like Outlook or Windows 
Mail. This automatically inserts the proper address to the record center and includes your client name 
in the subject line. You can then type your remarks. 
 

HELP 

Clicking on Help brings up the User Manual. 

 
LOGGING OUT 

Click Log Out  in the upper right to exit Web Access. Remember that if you forgot to save the order, 
you will be reminded on log out to save it. 
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Appendix D – The Web Data Entry Module 

Section 1 – Record Center Instructions 

TECHNICAL REQUIREMENTS 

There are two possible ways to deploy the Web Data Entry Module. The module can be hosted using 
either: 

 your company’s in-house server (a fixed IP address is required), or 
 a commercial web hosting service. 

NOTE: If you plan to plan to host the Web Access Module privately, note that Windows 2016 Server or 
higher and a static IP address are required with IIS 7.5 deployed. Please call for technical assistance 
and pricing. 

If you are hosting the Web Data Entry Module privately, after it is installed at your server, have your 
Web administrator add a link to your Login URL on your home page. When your customers are ready 
to use the Web Data Entry Module, they can simply click the link to access the Login page, enter their 
username and password, then click Login. 

SETTING UP USERS 

Since each client will need its own data batch set, a 
user name and password is required for each 
employee who will use the system.  

Go to the designated URL typically 
http://ip/WebDtaEntry/default.aspx  and log in at the 
Web Data Entry Login screen. Enter User Name = 
admin and the password. 

 

 

Fig. 186 

 

http://ip/WebDtaEntry/default.aspx
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THE WEB DATA ENTRY ADMINISTRATION SCREEN 

Fig.187  

After you log in, the Web Data Entry Administration screen appears (above).  

You can sort on any column by clicking its heading. There is a filter for Client code. To edit an existing 
user, double click any user.  To delete a user, highlight the use and click Remove Batch User at the 
top of the form. 

 

THE EDIT USER SCREEN 

To add a new user, click the Add Batch 
User at the top of the list.                       
.                                 Fig. 188           

Fields with a red * are required. 

 *Username – Note that each client may 
have multiple users. 

 *Password – May be changed at any 
time. 

 *Client code – This entry must   match 
the Client Code set up in Archive 
Manager. 

 *Client name – Your entry here 
populates the Client Name field at the top of the Box and Folder Entry screens.  

 Department Code – This entry must match the Department Code set up in Archive Manager. 
 Department Name – if entered in password setup will appear in the Box and Folder screens. 
 *Email – Enter the user’s email address.   

NOTE: Any user who is limited to a single department in Archive Manager will only be able to enter 
items for that department.  
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User options – Use the check boxes to permit users to: 

 enter locations (typically unchecked, since boxes are scanned the as they arrive) 
 enter Comments 
 enter Cross References  
 enter Record Titles 

When finished entering information, click Save or Save & New. You can then log off. 

 

THE CLEAN DATA FUNCTION 

This function allows you to delete all data from the 
Archive Manager Web Data Entry database before a 
certain date. Only batches sent will be deleted. Click 
the Clean button in the upper left and enter the date 
of older data to delete.                 Fig. 190 

 

You will receive a warning and a confirmation. 

 

FINALIZATION AND IMPORT 

When your client has finished doing all their data entry, they click Send to Record Center. This 
finalizes the batch, transmits the information to the record center via email, and removes the batch 
from the Existing Batches (and Batch Content) screen.  

 

Subject: AM Web Email - AM exported data from: 600 

To: orders@RMSArchives.com 

New batch from MOSLER . Batch Id: 345 

 
The batch is marked as sent and appears in the Web Data Entry tab of Import/ Export in Archive 
Manager. 

The batch data can be imported into Archive Manager using the instructions provided in Chapter 17 of 
this manual, Import/Export of Client Data. The email address for the record center is part of the set up 
procedure 

 

 

 

mailto:orders@RMSArchives.com
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Section 2 – End User Instructions 

WELCOME TO THE ARCHIVE MANAGER WEB DATA ENTRY MODULE! 

Archive Manager’s Web Data Entry Module permits you to enter data about boxes and folders going to 
your record center directly into the center’s database, without resorting to thumb drives or other media. 
You may request delivery of boxes and folders currently in the center. 

Box and folder records are submitted to the record center in batches or groups, which simplifies 
handling at both ends of the process. 

Follow the instructions in this section to set up your account, to access your records, or to request 
delivery. 

OBTAIN A USER NAME AND PASSWORD 

Before your firm can use the Archive Manager Web Data Entry Module, you must contact your archive 
service provider and designate the users who will have access to Web Data Entry. You may designate 
as many users as desired. The archive service provider will assign each person a user name and 
password for logging into the Web Access system. If your firm has multiple departments, each can 
designate its own users.  

NOTE: Users may be granted access to their own department’s records only, or to global access to 
records of all departments. When setting up contacts with your archive service provider, remember to 
specify which type of access is desired for each user.  

Optional authority for users 

In addition, users may be granted authority to: 

 enter locations (typically OFF, since boxes are scanned the as they arrive) 
 enter Comments 
 enter Cross References  
 enter Record Titles 

LOGGING IN  
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To access the Login Page, go to your archive service’s home page and click the link for Archive 
Manager Web Data Entry Module. The login page will appear. 

Enter the User Name and Password, and click Login. 

 
THE BATCHES LIST SCREEN  

 
After you have logged in, the Existing Batches screen will appear.  

This screen displays any batches you may have started but not yet submitted.    

 Add Batch – If there are no existing batches, press the Add Batch button to create a new batch. A 
new batch is created and a Batch Number is automatically assigned – you will automatically be 
directed to the new box data entry screen. 

 Edit Batch – Brings up the list of boxes in that batch. 
 Delete – Deletes the batch and all its boxes and folders. 
 Delete all batches – Deletes all batches and their corresponding boxes and folders. 
 Send to record center - Finalizes the batch, transmits the information to the record center, and 

removes the batch from the Existing Batches (and Boxes and Folders) – see below.                     
NOTE: Only click this button when you are ready to transmit your batch to the record center.  

 Print report – Provides a printable version in your browser -see below. 
 

THE BOXES IN THE BATCH SCREEN 

To see the content of a batch, click the Edit Batch button. The Boxes in the Batch screen appears, 
displaying a list of the boxes previously entered into this batch, as well as the following menu choices: 

 Add – enter information for a new box and folders  
 Edit – edit an existing box 
 Delete – deletes the selected box 
 Delete All – Deletes all boxes within the selected 

batch. 
 Add folder – add folders to a box 
 Show folders – brings up the list of folders for the 

selected box 
 Go to batch list – returns to batch list 
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 From Date – Date field  
used in conjunction with  
  

THE EDIT BOX DETAILS SCREEN 

From Batch list, click add batch or in the Box list click add to add a new box to an existing batch. The 
Edit Box Details screen appears.  

The following fields are present. (Fields 
with a red  
“ * ” are  required):  

 *Box # – 9 position numeric field 
(taken from the bar codes supplied by 
your record center).  
 Department – Department Code, a 
10 position alphanumeric field.  

 *Description – 50 character 
alphanumeric field for description of 
box contents  
 
 
the To Date field to describe the time 
interval covered by box contents.  

 

NOTE: Dates are entered in format MM/DD/YYYY, but you do not need slashes in data entry. For 
example, typing 051521 results in 05/15/2021. 

 To Date – Date field used in conjunction with the From Date 
 Destroy Date – Date field indicating the month, day, and year this box is eligible for destruction.  If 

left blank, will populate with 12/31/9998 by default, which Archive Manager interprets to mean  
permanent. 

 Record Title – Record Title code; must match code set up in Archive Manager. 
 Location (optional) – The location code for this box (if selected). 
 Cross Reference (optional) – 10 positions; typically the client’s box or reference number (if selected). 
 Comments (optional) – An unlimited text field for additional box information (if selected). 
Clicking Save & New carries the data forward to the next box for Department, Destroy Date, From and 
To Dates, Description, and Record Title. 

Explanations of other buttons: 

 Add folder – Add folders to box 

 Folders – Lists folders within box 

 Save – Returns you to the box list 

 Cancel – Cancels your add/ edit and returns you to the box list 



 

Appendix D – The Web Data Entry Module  Page 146 
 
 
 

THE EDIT FOLDER DETAILS SCREEN 

To add a new folder to a batch, click the Add 
Folders in the Box Edit Screen or on the Box List. 
The Edit Folder Details screen appears.   

The Box Number, Department, From and To 
Dates, and Destroy Date information are captured 
from the current box, and a new Folder Number is 
automatically created. 

 

The following fields are present. Fields with a red “ 
* ” are  required: 

 *Folder # – 3 position numeric; populated 
automatically, but may be changed manually. 

 ID – 10 position alphanumeric; typically, the 
last name or initials of the person in your 
company who is responsible for this folder, such a partner, manager or corporate officer.  

 Matter No. – 13 characters alphanumeric; typically case numbers, patient numbers, claim 
numbers, etc. 

 *Major Description – 50 characters alphanumeric; general description of folder (i.e., ABC Co. vs 
XYZ Co.). 

 Minor Description – 50 characters alphanumeric; detail of folder contents (i.e., Depositions for 
ABC Co.). 

 From Date – Date field used in conjunction with the To Date field to describe the time interval 
covered by folder contents; captured from Box data, but can be changed manually.  

 To Date – Date field used in conjunction with the From Date; captured from Box data, but can be 
changed manually. 

 Destroy Date – Date field indicating when folder box is eligible for destruction; captured from Box 
data, but can be changed manually. 

 Cross Reference (optional) – Your file or reference number (if selected, maximum of 10 
positions). 

 Comments (optional) – An unlimited text field for additional information about a box (if selected). 

Click Save & New save the current data and open a fresh Edit Folder Details screen. As previously, 
the data is carried forward for ID, Matter #, Major Description, Minor Description, and From and To 
Dates. 
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FOLDERS IN THE  BOX SCREEN 

Clicking Save takes you to the Folders List screen, where you can review the contents of the selected 
box, or choose a folder to edit or delete.  

To enter more boxes or to preview the current batch, click Go To Box Page to return to the Boxes in 
the Batch screen. 

 
Explanations of buttons: 

 Add – Add folders to box 

 Edit – Edit an existing folder 

 Delete – Deletes the selected 
folder 

 Go to box list – Returns you to the box list 

 Go to batch list – Returns you to the batch list 

 Delete all – Deletes all the folders for this box 
 

PREVIEWING 

It is good practice to preview the contents of your batch before you submit to the record center. From 
the Batch List screen, click the Print Report button to list the boxes and folders in the current batch to 
the screen.  

 
You can then click Print to send the report to your printer. 
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FINALIZATION AND IMPORT 

When you have finished doing all your data entry, return to the Batch List and click Send to Record 
Center. This finalizes the batch, transmits the information about your boxes and folders to the record 
center, and removes the batch from the Batch List (and the Box and Folders Lists). 

NOTE: Only click this button when you are 
ready to transmit your batch to the record 
center.  

 
 

 
You will receive confirmation that your batch has been sent. 

 

 

 

 

 
LOGGING OUT 

Click Logoff in the upper left of the main background screen to exit Web Data Entry. You need to be at 
the Batch List to log out. Remember that if you forgot to send your batch, you can always log in again 
and send it from the Batch list page. 
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